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Getting Started

Welcome to the official Apple Pro Training Series course for Logic

Pro X 10.1. This book is a comprehensive introduction to professional
music production with Logic Pro X. It uses real-world music and hands-
on exercises to teach you how to record, edit, arrange, mix, produce,
and polish audio and MIDI files in a professional workflow. So let’s get

started!

The Methodology

This book takes a hands-on approach to learning the software, so youwll work
through the project files and media you download from www.peachpit.com.
It’s divided into lessons that introduce the interface elements and ways of
working with them, building progressively until you can comfortably grasp the
entire application and its standard workflows.

Each lesson in this book is designed to support the concepts learned in the

preceding lesson, and first-time readers should go through the book from start

to finish. However, each lesson is self-contained, so when you need to review a
topic, you can quickly jump to any lesson.

The book is designed to guide you through the music production process as it
teaches Logic. The lessons are organized into four sections.

Xi
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Getting Started

Lessons 1-3: Exploring the Interface and Working with Real Instruments

In this section, you'll explore the fundamentals of Logic Pro X and learn to record and
edit audio.

Lesson 1 starts you out with an overview of the entire process. You'll become familiar with
the interface and the various ways to navigate a project; use Apple Loops to build a song
from scratch; and then arrange, mix, and export the song to an MP?3 file.

Lessons 2 and 3 dive deeper into typical situations you may encounter when recording from
microphones or other audio sources. You'll edit recordings to select the best portions of multiple
takes, remove clicks, align recordings, and even reverse a recording to create a special effect.

Lessons 4-6: Working with Virtual Instruments

Lesson 4 describes how to produce virtual acoustic and electronic drummer performances
using Drummer, Drum Kit Designer, and Drum Machine Designer. You will choose the
right drummer for the project, swap a drum kit with the kit of another drummer, edit the
patterns, change which kit elements the drummer plays, shape an interpretation, and pre-
cisely control where fills are placed.

Lessons 5 and 6 immerse you in using software instruments. After choosing virtual instru-
ments and recording MIDI performances, you'll map Smart Controls to various plug-ins
and assign them to your MIDI controller. Using the free Logic Remote app, you'll control
Logic from your iPad, and then create virtual performances in MIDI editors using your
mouse or your MIDI keyboard. The Logic Remote icon will appear in the margin when
related content appears.

Lessons 7-8: Building a Song

In Lessons 7 and 8, you'll apply Flex editing to precisely adjust the timing and pitch of
notes in an audio recording. Varispeed will allow you to work with your project at differ-
ent tempos. You'll add tempo changes and tempo curves to a project, match the tempos
of multiple tracks, and make a track follow the groove of another track. Also covered

are tuning a vocal recording, editing a project’s regions in the workspace to complete an
arrangement, and adding and removing sections of a project.

Lessons 9-10: Mixing and Automating a Song

Lessons 9 and 10 instruct you in mixing audio and MIDI files into a final project: adding
audio effects, adjusting levels, panning, EQing, adding delay and reverb, automating the



Preparing Your Logic Workstation

mix by creating automation curves on your screen, and altering parameter values in real
time with the mouse or a MIDI controller.

Appendix A describes how to use external MIDI devices, and Appendix B lists a wealth of
useful keyboard shortcuts.

System Requirements

Before using Apple Pro Training Series: Logic Pro X 10.1, you should have a working
knowledge of your Mac and the Mac OS X operating system. Make sure that you know
how to use the mouse and standard menus and commands, and also how to open, save,
and close files. If you need to review these techniques, see the printed or online documen-
tation included with your system.

Logic Pro X and the lessons in this book require the following system resources:

» Mac computer with an Intel processor, including:
4 GB of RAM
Display with 1280 x 768 or higher resolution
Mac OS X v10.9.5 or later
Minimum 41 GB of disk space to install Logic Pro X and its media content
High-speed Internet connection for installation

» A USB-connected MIDI keyboard (or compatible MIDI keyboard and interface) to
play software instruments

P A low-latency multi-I/O audio interface (highly recommended for audio recording)

» An iPad (optional) for controlling Logic using the Logic Remote iPad app

Preparing Your Logic Workstation

The exercises in this book require that you install Logic Pro X along with its default media
content. If you have not yet installed Logic, you may purchase it from the App Store.
When your purchase is completed, Logic Pro X will automatically be installed on your
hard drive.

All the instructions and descriptions in this book assume that you installed Logic Pro X
on a Mac without any legacy Logic media, and that you downloaded all the additional
media except for the Legacy and Compatibility content.

xiii



Xiv  Getting Started

When you first open Logic Pro X, the app will automatically download and install about 2
GB of essential content. An alert then offers to download additional media content.

| Download of basic content completed.

| Additional content packages (such as Sampler

| Instruments and Apple Loops) are available to download.
—_— Click Download Additional Content to do 50 now or
choose Logic Pre X > Download Additional Content
anytime later. Click OK to start using Logic Pro X.

| Download Additional Content | oK

Click Download Additional Content to make sure that you install all the Logic Pro X
media content. After you click Download Additional Content, the Additional Content
window opens. Click the Select All Uninstalled button at the bottom left, and click the
“Legacy and Compatibility” checkbox twice to deselect it. Depending on the speed of your
Internet connection, the download process may take several hours.

NOTE » If you have already installed Logic Pro X but did not install the additional con-
tent, choose Logic Pro X > Download Additional Content, click Select All Uninstalled
(make sure the Legacy and Compatibility content is not selected), and click Install.

After you've installed all additional media content, your Additional Content window
should look like the following figure:

ntial Sounds and Instruments for Logic Pro and MainStage

Drum Kit
Drum Machine

Guitar

Piano

Vintage Mellotron

Installed

Jam Pack Voices

Select All Uninstalled Cancel
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NOTE » If you have previously installed the Legacy and Compatibility content, or if
you have earlier versions of Logic installed on your Mac, you may not always see the
same results as those shown in the book, especially when viewing the Library, the
Loop Browser, or the plug-in settings menus.

Downloading and Using the Logic Lesson Files

The downloadable content for Apple Pro Training Series: Logic Pro X 10.1 includes the
project files you will use for each lesson, as well as media files that contain the audio and
MIDI content you will need for each exercise. After you save the files to your hard disk,
each lesson will instruct you in their use.

To download these files, you must have your guide’s access code—provided on a card in
the back of the printed editions of this book or on the “Where Are the Lesson Files?” page
in electronic editions of this book. When you have the code:

1 Go to www.peachpit.com/redeem, and enter your access code.
2 Click Redeem Code, and sign in or create a Peachpit.com account.

3 Locate the downloadable files on your Account page under the Lesson & Update
Files tab.

4 Click the lesson file link and download the file to your Mac desktop.

NOTE » If you purchase or redeem a code for the electronic version of this guide
directly from Peachpit, the lesson file link will automatically appear on the Lesson &
Update Files tab without the need to redeem an additional code.

5 After downloading the file to your Mac desktop, you'll need to unzip the file to access
a folder titled Logic Pro X Files, which you will save to your Mac desktop.

Logic Pro X Files contains two subfolders, Lessons and Media, that contain the work-
ing files for this course. Make sure you keep these two folders together in the Logic
Pro X Files folder on your hard disk. If you do so, your Mac should be able to main-
tain the original links between the lessons and media files. Each lesson explains which
files to open for that lesson’s exercises.
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Using Default Preferences and Selecting the Advanced Tools

All the instructions and descriptions in this book assume that you are using the default
preferences (unless instructed to change them). At the beginning of Lesson 1, you will be
instructed how to show advanced tools and select all additional options.

If you have changed some of your Logic Pro X preferences, you may not realize the same
results as described in the exercises. To make sure that you can follow along with this
book, it’s best to revert to the initial set of Logic preferences before you start the lessons.
Keep in mind, however, that when you initialize preferences, you lose your custom set-
tings, and later you may want to reset your favorite preferences manually.

1 Choose Logic Pro X > Preferences > Advanced Tools.

2 Under Additional Options, select Audio, Surround, MIDI, Control Surfaces, Score,
and Advanced Editing, and then close the preferences window.

3 Choose Logic Pro X > Preferences > Initialize All Except Key Commands.

A confirmation message appears.

4  Click Initialize.
Your preferences are initialized to their default states.

If you're jumping ahead to a lesson other than Lesson 1, make sure that you select all
additional options as detailed in step 2.

Using the U.S. Key Command Preset

This book assumes that you are using the default initialized key command preset for a
U.S. keyboard. So you may find that some of the key commands in your Logic installation
do not function as they are described in this book.

If at any point you find that the key commands don’t respond as described in this book,
make sure the U.S. key command preset is selected on your Mac by choosing Logic Pro X >
Key Commands > Presets > U.S.
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Screen Resolution

Depending on your display resolution, some of the project files may appear different on
your screen than they do in the book. When you open a project, if you can’t see the whole
Arrange window, move the window until you can see the three window controls at the left
of the title bar, and click the Zoom button (the third button from the left) to fit the win-
dow to the screen.

When using a low display resolution, you may also have to zoom or scroll more often than
instructed in the book when performing some of the exercise steps. In some cases, you
may have to temporarily resize or close an area of the Arrange window to complete an
action in another area.

About the Apple Pro Training Series

Apple Pro Training Series: Logic Pro X 10.1 is both a self-paced learning tool and the
official curriculum of the Apple Pro Training and Certification Program. Developed by
experts in the field and certified by Apple, the series is used by Apple Authorized Training
Centers worldwide and offers complete training in all Apple Pro products. The lessons are
designed to let you learn at your own pace. Each lesson concludes with review questions
and answers summarizing what you've learned, which can be used to help you prepare for
the Apple Certified Professional—Logic Pro X Certification Exam.

For a complete list of Apple Pro Training Series books, see the ad at the back of this book
or visit www.peachpit.com/apts.

Apple Pro Certification Program

The Apple Pro Training and Certification Program is designed to keep you at the forefront
of Apple digital media technology while giving you a competitive edge in today’s ever-
changing job market. Whether you're an editor, graphic designer, sound designer, special-
effects artist, or teacher, these training tools are meant to help you expand your skills.

Upon completing the course material in this book, you can become a certified Apple Pro
by taking the certification exam at an Apple Authorized Training Center. Successful cer-

tification as an Apple Pro gives you official recognition of your knowledge of Apple pro-

fessional applications while allowing you to market yourself to employers and clients as a
skilled, pro-level user of Apple products.
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Getting Started

For those who prefer to learn in an instructor-led setting, Apple offers training courses at
Apple Authorized Training Centers worldwide. These courses, which use the Apple Pro
Training Series books as their curriculum, are taught by Apple Certified Trainers and bal-
ance concepts and lectures with hands-on labs and exercises. Apple Authorized Training
Centers have been carefully selected and have met Apple’s highest standards in all areas,
including facilities, instructors, course delivery, and infrastructure. The goal of the pro-
gram is to offer Apple customers, from beginners to the most seasoned professionals, the
highest-quality training experience.

For more information, please see the ad at the back of this book, or to find an Authorized
Training Center near you, go to training.apple.com.

Resources

Apple Pro Training Series: Logic Pro X 10.1 is not intended as a comprehensive reference
manual, nor does it replace the documentation that comes with the application. For com-
prehensive information about program features, refer to these resources:

» Logic Pro Help, accessed through the Logic Pro X Help menu, contains a description
of most features. Other documents available in the Help menu can also be valuable
resources.

» The Apple websites www.apple.com/logic-pro/ and www.apple.com/support/logicpro/.

P The Logic Pro Help website, an online community of Logic users moderated by the
author of this book, David Nahmani: www.logicprohelp.com/forum.
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Time This lesson takes approximately 75 minutes to complete.

Goals Create a new project with a Drummer track
Choose a drummer and drum kit
Edit the drummer performance
Arrange the song structure
Edit performances in the new sections
Customize the drum kit
Tune and dampen individual kit pieces
Work with electronic drummers

Customize drum machines

Convert Drummer regions to MIDI regions




Lesson 4

Produce a Virtual
Drum Track

In most popular modern music genres, drums are the backbone of the
instrumentation. They provide the foundation for the tempo and the
groove of the piece. For recording sessions in which the instruments
are not tracked at the same time, drums are usually recorded or pro-
grammed first so that the other musicians can record while listening to

their rhythmic reference.

To meet today’s high production standards, producing drum tracks
usually involves using several techniques, including live recording,
programming, sampling, audio quantizing, and sound replacement. In
Logic Pro X, you can speed up the process by taking advantage of the
new Drummer feature along with its companion software instruments,

Drum Kit Designer and Drum Machine Designer.

In this lesson, you will produce virtual indie-rock, hip-hop, and elec-
tro-house drum tracks. After selecting a genre and choosing the best
drummer for your project, you will adjust the drummer’s performance,
making her play busier patterns or simpler ones, louder or softer, and
changing the feel, almost like a producer would communicate with a

real drummer in a recording session.
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Creating a Drummer Track

Drummer is a new Logic Pro X feature that allows you to produce drum tracks using a
virtual drummer with its own playing style. Its performance is placed in Drummer regions
on a Drummer track. You edit the performance data in the regions using the Drummer
Editor. The virtual drummer also has its own drum kit loaded in a software instrument
plug-in called Drum Kit Designer.

First, let’s open a new project, add a Drummer track, and examine the display of the drum
performance in the Drummer region.

1 Choose File > New (or press Command-Shift-N).
A new project opens along with the New Tracks dialog.

2 In the New Tracks dialog, select Drummer, make sure the Genre pop-up menu is set
to Rock, and click Create.

Software Instrument Audio ' m
External MIDI Guitar or Bass
¥ Details:
Genre: Output:
Rock = [ Output 1 +2 =
[ | Open Library Output device: SF+MIC £
? Cancel | | Create |

A Drummer track is created along with two eight-bar Drummer regions. At the
bottom of the main window, the Drummer Editor opens, allowing you to choose a
drummer and drum kit, and to edit the performance in the Drummer regions that are
selected in the workspace. The track is named SoCal, which is the name of the drum
kit used by the default virtual drummer in the Rock category, Kyle.
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Drummer regions

o i . st e L R LG T R R T T B T T (L o)

Drummer Editor

Press the Spacebar to listen to the two Drummer regions.

In the first region, the drummer starts with a crash cymbal and plays a straightfor-
ward rock pattern. At the end of the first Drummer region, a drum fill leads into the
next section.

In the second region, the drummer switches from the hi-hat to the ride cymbal and plays
a more complex pattern: The kick is busier, and the snare adds ghost notes (very quiet
hits) between beats. As in the first region, the drummer plays a fill at the end of the first
four measures, followed by a crash. He plays another fill at the end of the region.

Let’s take a closer look at a Drummer region.

Control-Option-drag over the first bar of the first Drummer region. If necessary, con-
tinue zooming vertically by dragging the vertical zoom slider (or pressing Command-
Down Arrow) until you can see two lanes in the Drummer region.

157
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Crash cymbal

Stronger hi-hat

_— e P e - -

Softer hi-hat

Snare
Kick

dBAN.

The Drummer region displays drum hits as triangles on lanes, roughly emulating the

look of drum hits on an audio waveform. Kicks and snares are shown on the bottom
lane; cymbals, toms, and hand percussions are on the top lane.

5 In the upper half of the ruler, drag a one-measure cycle area at bar 1.
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6 Listen to the first bar a few times while looking at the drum hits in the Drummer region.

Although you cannot edit individual drum hits in the Drummer region, the region
display gives you a quick glance at the drummer’s performance.

MORE INFO » At the end of this lesson you will convert Drummer regions to MIDI
regions. In Lesson 6, you will learn how to edit MIDI regions.

7 Turn off Cycle mode.

8 In the workspace, click the background and press Z to zoom out and see both
drummer regions.

Now you can read the Drummer regions. In the next exercise, you will listen to multiple
drummers and several performance presets. Later, you will zoom in again to see the
Drummer regions update as you adjust their settings in the Drummer Editor.

Choosing a Drummer and a Style

Each drummer has his own playing style and drum kit, and those combine to create a
unique drum sound. Before you start fine-tuning the drummer’s performance, you need
to choose the right drummer for the song.

In the Drummer Editor, drummers are categorized by music genres. By default, choosing
a new drummer means loading a new virtual drum kit and updating Drummer region set-
tings; but sometimes you may want to keep the same drum kit while changing the drum-
mer, which you will do in this exercise.
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1

In the character card, click the drummer.

All the drummers from the Rock category are displayed.

2  Place the mouse pointer over Anders (the first drummer in the second row).

5

nfluenced by heawvy, riffing rock bands, Anders
plays grinding beats on a massive-sounding kit.

A help tag describes that drummer’s playing style and the sound of his drum kit. Let’s
get to know the other drummers.

Continue by placing the pointer over other rock drummers to read their descriptions.
When you're through, click the drummer named Jesse.

In the workspace, the two Drummer regions update to display Jesse’s performance.

In the workspace, click the first Drummer region (at bar 1) to select it.

The Drummer Editor shows the settings for the selected Drummer region. A yellow
ruler allows you to position the playhead anywhere within the region, and you can
click the Play button to the left of the ruler to preview the Drummer region. As in the
Tracks area, you can also double-click the ruler to start and stop playback.

In the Drummer Editor, click the Play button.
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Play button Playhead

Broken Glass

The selected region plays in Cycle mode, and the cycle area automatically matches the
region position and length. The selected region is soloed—indicated by a thin yellow
frame—and the other region is dimmed. Soloing the region helps you focus on the
drums when you have other tracks in the project.

Although you will later fine-tune the drummer’s performance, Jesse’s busy, syncopated
drum patterns are not a good fit for this indie-rock song. You are looking for a drum-
mer with a simple, straightforward style that more appropriately serves the song.

6 Stop playback.

In the Tracks area, Cycle mode is automatically turned off, the dimmed cycle area
returns to its original position and length, and the selected region is no longer soloed.

7 In the Drummer Editor, click the Genre menu at the top of the character card, and
choose Alternative.

_ v'Rock
Alternative

Songwriter

R&B |ken Glass
Electronic
Hip Hop

Drummers from the Alternative category are shown.

8 Click the first drummer, Aidan.
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9 In the Drummer Editor, click the Play button.

While the region is playing back in Cycle mode, you can try selecting other region
settings presets to explore Aidan’s full range of playing style.

10 In the Presets column, click a few different presets while the region plays back.

When you click a preset, the region settings update and you can hear another perfor-
mance from the same drummer.

11 Without stopping playback, from the Genre menu, choose Rock.

12 Click the fourth drummer, Max.

A dialog explains how to retain region settings when changing the drummer.

13 In the dialog, select “Do not show this message again,” and click Change Drummer.

settings on this track. To keep these
changes, select “Keep settings when
changing drummers" in the Presets pop-up
menu in the Drummer Editor.

Changing the drummer will replace
@ changes you have made to the region
-
-———""-J

Do not show this message again

Cancel arlge Dru \mer

Listen to a few of Max’s presets. Although Max’s hyperactive performance is not what
you're looking for, the drum kit sounds punchy. Let’s assign the first drummer, Kyle,
to play on Max’s drum set, East Bay Kit.
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14 In the character card, click the drummer to display the drummers.

You can Option-click a new drummer to select that drummer while keeping the current
drum kit.

15 Option-click Kyle.

East Bay

Kyle is now playing Max’s East Bay Kit. Let’s make him play a bit faster.

16 In the control bar, set the tempo to 142 bpm.

e 1213 142 Crmaj

17 Stop playback.

You have found a drummer that plays the straightforward style you're seeking for this
project, paired a punchy-sounding drum Kit, and set a tempo that will drive your indie-
rock song. You are now ready to customize the performance.

Editing the Drum Performance

In a recording session with a live drummer, the artist, the producer, or the musical direc-
tor must communicate their vision of the completed song. They may ask the drummer to
play behind or ahead of the beat to change the feel of the groove, or to switch from the
hi-hat to the ride cymbal during the chorus, or to play a drum fill in a specific location.
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In Logic Pro X, editing a drummer performance is almost like giving instructions to a real

drummer. In this exercise, you will play a drum region in Cycle mode as you adjust the

drummer settings.

1

In the workspace, make sure the first Drummer region is still selected, and in the
Drummer Editor, click the Play button.

Next to the presets, an XY pad with a yellow puck lets you adjust both the loudness
and the complexity of the drum pattern.

As the region plays, drag the puck, or click different locations inside the pad, to
reposition it.

EI3» To undo your most recent Drummer Editor adjustment, press Command-Z.

After positioning the puck, you must wait for the region to update (update time varies
depending on your computer). If you drag the puck constantly, the region will not update.

As you position the puck farther to the right, the drum pattern becomes more com-
plex; and as you move the puck toward the top of the pad, the drummer plays louder.
Try placing the puck in the pad’s corners for extreme settings, such as soft and simple,
or loud and complex.

As the drummer plays softer, he closes the hi-hat and switches from hitting the snare
drum on the skin to playing rim clicks (hitting only the rim of the drum). As he plays
louder, he opens the hi-hat and start playing rim shots (hitting the skin and the rim
simultaneously for accent).

Let’s make the drummer play a solid, straightforward beat in this first Drummer
region, which will be used for the first verse of the song.
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3 Settle for a puck position where the drummer plays a rather simple and fairly loud
pattern.

o

You can still hear a lot of syncopation on the kick drums. To the right of the XY pad,
you can choose from several Kick & Snare pattern variations.

4 Drag the Kick & Snare slider to position 2 (or click the second increment on the slider).

K> [n multitrack projects, when you select the Follow checkbox, a pop-up menu
appears instead of the Kick & Snare slider. The menu lets you choose a track to influ-
ence what the drummer plays on the kick and snare.

The drummer now simply alternates kick and snare on every beat. If you don’t hear
the drummer play the snare on beats 2 and 4, slightly readjust the horizontal position
of the puck in the XY pad so it’s in the same position as in the figure following step 3.

Listen to the hi-hat: It is currently playing eighth notes.

5 Click the first increment on the Hi-Hat slider.

The hi-hat now plays only on the beat (quarter notes), which works well for up-
tempo songs.
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The drummer is playing a fill in the middle of the region (before bar 5) and another
at the end (before bar 9). Let’s get rid of the first fill and keep only one at the end.

6 Look at the region in the workspace while trying different positions for the Fills knob,
and drag the Fills knob down until you see the fill before bar 5 disappear. You should
still see a fill at the end of the region.

NOTE » Clicking the small lock icon next to the Fills and Swing knobs locks the knob
into position as you preview presets or drummers.

EII»» Each time you adjust a setting in the Drummer Editor, the selected region is
refreshed and the drummer plays a new subtle variation. Dragging the Fills knob by
a tiny amount is a quick way to refresh a region. You can also click the Action pop-
up menu next to the Presets menu and choose Refresh Region; or Control-click the
region in the workspace, and from the shortcut menu, choose Edit > Refresh Region.

>>>>>>>>r»r»»»»»»»»»»»»»»»»»»»)
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You now have a very straightforward beat. Because the drummer plays less now, he

can make the hi-hat ring a bit more.
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7 In the Drummer Editor, click the Details button to display three knobs.

Swing

8 Below the Hi-Hat knob, deselect the Automatic option.

9 Drag the Hi-Hat knob up to open it a little bit.

This verse’s drum pattern now sounds great, so let’s move on to the second Drummer
region, which you’ll use for the chorus.

10 In the Drummer Editor, click the Details button to hide the three buttons.
11 Stop playback.

12 In the workspace, select the second Drummer region.

167
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Hi-hat

Hand percussions
Cymbals
Toms

Snare

Kick drum

The Drummer Editor updates to show the second region’s settings. On the drum Kkit,
the hi-hat is now dimmed, while the cymbals are highlighted in yellow. The drummer
no longer plays the hi-hat, but instead plays a ride or crash cymbal in that region.

13 In the Drummer Editor, click the Play button.

You can hear the second region in Cycle mode. The drummer is playing the ride
cymbal on every eighth note. For a more powerful chorus, you instead want it to play
crash cymbals on every beat.

14 Click the first increment of the Cymbals slider.

You now hear crash cymbals on every beat. Even for a chorus, the beat is a little too busy.

15 On the XY pad, drag the puck toward the left to create a simpler beat.
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Let’s listen to the verse going into the chorus.
16 Stop playback.

17 Go to the beginning of the song and listen to both Drummer regions.
You now have a simple, straightforward beat for the verse, and then the drummer
switches to the crash cymbal for the busier chorus pattern.

You have carefully crafted two eight-measure drum grooves: one for the verse and one
for the chorus. They are the two most important building blocks of the song you will now
start arranging.

Arranging the Drum Track

In this exercise, you will lay out the song structure and populate the Drummer track with
Drummer regions for the whole song.

Using Markers in the Arrangement Track

Using the Arrangement track, you will now create arrangement markers for all the sec-
tions of your song. You'll adjust their lengths, positions, and order, and fill all the new sec-
tions with Drummer regions.

1 At the top of the track headers, click the Global Tracks button (or press G).

Edit Functions

4

Arrangement
Marker
Signature

Tempo

The global tracks open, with the Arrangement track at the top. You won’t need the
other global tracks, so you can hide them.

169
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2 Control-click a global track header, and choose Configure Global Tracks (or press
Option-G).

Enable All Disable All Revert

A shortcut menu opens in which you select the global tracks you want to display.

3 Deselect the Marker, Signature, and Tempo tracks, and click outside the shortcut
menu to close it.

The Arrangement track is now closer to the regions in the workspace, making it easier
to see their relationships.

4 In the Arrangement track header, click the Add Marker button (+).

1

VP

An eight-measure arrangement marker named Intro is created at the beginning of the

song. By default, arrangement markers are eight bars long and are placed one after the
other, starting from the beginning of the song. Let’s rename the marker.

5 Click the name of the marker, and from the menu, choose Verse.
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A e s

Click the Add Marker button (+) to create a new marker, and make sure it's named Chorus.

You will now create a marker for a new intro section and insert it before the Verse
and Chorus markers.

In the Arrangement track header, click the Add Marker (+) button.

An eight-bar marker is created.

Click the name of the new marker, and from the pop-up menu, choose Intro.

A four-measure intro will be long enough, so you can resize the Intro marker before
moving it.

Drag the right edge of the Intro marker toward the left to shorten it to four bars.

-4000

Click the marker away from its name (to avoid opening the Name pop-up menu), and
drag the Intro marker to bar 1.

Drusmmer

1111 -16 0

0o
L e e e T S »»”
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11

12

13

14

15

The Intro marker is inserted at bar 1, and the Verse and Chorus markers move to the
right of the new Intro section. In the workspace, the Drummer regions move along
with their respective arrangement markers.

As with regions in the workspace, you can Option-drag a marker to copy it.

Press Command-Left Arrow to zoom out horizontally and make space to the right of the
existing song sections. Option-drag the Verse marker to bar 21, right after the chorus.

The Verse marker and the Drummer region are copied together.

T ST |11 1 e ey

AR A

Option-drag the Chorus marker to bar 29, after the second verse.

The Chorus and the Drummer region are copied together.

The song is taking shape. You will now finish arranging the song structure with a
bridge, a chorus, and an outro section. As you place the last three markers, continue
zooming out horizontally as necessary.

In the Arrangement track header, click the Add Marker (+) button.

A Bridge marker is created after the last chorus.

In the Arrangement track header, click the Add Marker (+) button two more times to
create markers for the Chorus and Outro sections.

Make sure the two last markers have the correct names, Chorus and Outro.

Let’s shorten the outro section a bit.
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16 Resize the Outro marker to make it four bars long.

Chorus

th: 4000 -4000

The song structure is now complete, and you can add Drummer regions to fill out the
empty sections.

17 On the Drummer track, Control-click the background and choose Populate with
Drummer Regions.

Chorus Outro

New Drummer regions are created for all the empty arrangement markers.

18 Listen to the drum track, focusing on the new sections.

New patterns were automatically created for each new Drummer region.

K> To delete all the regions below an Arrangement marker, select the marker,
and press Delete. To remove the Arrangement marker, press Delete again.

Amazing as the playing is, Kyle (the drummer) might not have guessed what you had in
mind for each section. You will now edit some of the new regions to adjust the drummer’s
performance.

Editing the Intro Drum Performance

In this exercise, you will make the drummer play the hi-hat instead of the toms. Later,
you’ll cut the Intro region in two so that you can use different settings for the second
part of the intro and make the drummer play a progressively louder and more complex
pattern.

173



174 Produce a Virtual Drum Track

1 In the workspace, click the background to deselect all regions, and click the Intro
region to select it.

The Drummer Editor shows its settings.

Throughout this exercise you can click the Play button in the Drummer Editor to
start and stop playback, or you can navigate the workspace by pressing the Spacebar
(Play or Stop) and the Return key (Go to Beginning).

2 Listen to the Intro.

Let’s make the drummer play the hi-hat instead of the toms.

3 In the Drummer Editor, click the hi-hat.

When you click the hi-hat, the toms are muted automatically. Aside from the kick and
snare, the drummer can focus on the toms, the hi-hat, or the cymbals (ride and crash).

The drums are still a little too loud and busy for this intro.
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4 In the XY pad, drag the puck toward the bottom left.

The drums are softer, but the transition into the first verse at bar 5 is a little abrupt.
Making the drums play crescendo (increasingly louder) during the intro will help
build up some tension leading into that verse. To make the loudness evolve through-
out the intro, you will cut the Intro region in two.

5 Stop playback.

6 Hold down Command to use the Marquee tool, and double-click the Intro region
at bar 3.

Intro

The region is divided into two two-measure regions. When a region is divided, the drum-
mer automatically adapts his performance, and plays a fill at the end of each new region.
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7 Select the first Intro region.

8 In the Drummer Editor, drag the Fills knob all the way down.

Notice how the crash disappears from the first beat of the following region. Even
though it is in another region, the crash is actually a part of the fill. Now let’s create
the crescendo.

9  Select the second Intro region, and in the XY pad, drag the puck up to make the

drummer play louder.

10 Listen to the whole intro going into the first verse.

Intro

The drummer automatically starts playing louder before the end of the first intro

region, which transitions into the louder second region and creates a nice tension at
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the start of the song. At bar 5, a crash punctuates the fill at the end of the intro. The
straightforward groove continues in the Verse section, with the hi-hat a little less open
to leave space to later add a singer.

Editing the Bridge Drum Performance

In a song, the bridge serves to break the sequence of alternating verses and choruses.
Often, the main idea of the song is exposed in the choruses, and verses help support or
develop that statement. The bridge can present an alternate idea, a different point of view.
Departing from the main idea of the song increases the listener’s appreciation for return-
ing to the chorus at the end of the song—almost like taking a vacation can increase your
appreciation for going back home.

For this fast, high-energy indie-rock song, a quieter bridge in which the instruments play
softer will offer a refreshing dynamic contrast. Playing softer does not mean the instru-
ments have to play less, however. In fact, you will make the drums play a busier pattern
during this bridge.

1 Listen to the Bridge region.

K> When pressing the Spacebar to play a section, you can use Cycle mode to
ensure that playback always starts at the beginning of the section. Drag a section’s
arrangement marker into the ruler to turn on Cycle mode and create a cycle area that
matches the section.

| Bridge

»»»bnnb-»»»b-»»mn--»nm»b-n»b-»n»m»mvmbn }M-)»
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The drummer plays at the same level as in the previous sections, but he plays more

here. You need to bring down the energy level.
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2  Select the Bridge Drummer region.

3 In the XY pad, position the puck farther down and all the way to the right.

The drummer is still playing a lot, but he’s much quieter. To take this bridge into a
different tonal direction, you want Kyle to play toms.

4  On the drum kit, mute the snare and unmute the toms.
The hi-hat is muted automatically when you unmute the toms.

Let’s choose a busier pattern for the toms.

5 On the Toms slider, click increment 3.

e

Kyle is now playing sixteenth notes on the toms, which creates a mysterious vibe simi-
lar to tribal percussion.

Kyle plays slightly ahead of the beat during the bridge. However, the timing nuance is
subtle, and it’s difficult to hear without other instruments to compare with Kyle’s tim-
ing. Let’s turn on the metronome and experiment with the feel of the performance.

6 In the control bar, click the Metronome button (or press K).

7 In the Drummer Editor, click the Details button to display the three setting knobs.



Arranging the Drum Track

8 Try setting different positions of the Feel knob, and then listen to the results.

Pull Push

Listen to the way the drums play compared to the metronome. Don't be afraid to drag
the Feel knob all the way up or down to hear the effect of extreme Feel settings.

P Dragging the Feel knob toward Push makes the drummer play ahead of the beat.
He sounds as if he’s rushing, thereby creating a sense of urgency.

P Dragging the Feel knob toward Pull makes it play behind the beat. He sounds as
if he’s lazy or late, and the groove is more relaxed.

Settle on a Feel knob position more toward Pull to realize a reasonably relaxed groove.
9 Click the Details button to hide the three setting knobs.
10 Turn off Cycle mode.

11 In the control bar, click the Metronome button (or press K) to turn it off.

You have radically changed the drummer’s performance in that region. Kyle now plays the
bridge with a busy tribal pattern on the toms. He uses restraint, hitting softly and behind
the beat, with a slight crescendo toward the end. The quiet and laid-back yet complex
drum groove brings a welcome pause to an otherwise high-energy drum performance,
and builds up tension leading into the last two sections.

Editing the Chorus and Outro Sections

You will now finish editing the drummer’s performance by adjusting the settings of the
last two Chorus and Outro Drummer regions in your workspace.

1 Select the Chorus region after the bridge and listen to it.

That Chorus region was created when you populated the track with Drummer regions
earlier in this lesson. It doesn’t have the same settings as the previous two choruses
and sounds busier, except for Kyle playing the ride cymbal instead of the crash.
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2  On the Cymbals slider, click the first increment.

The drummer now plays the crash, and this last chorus is more consistent with the
previous two choruses.

3 Select the Outro region at the end of the track and listen to it.

The drummer plays a loud beat, heavy on the crash, which could work for an outro.
You will, however, make it play double-time (twice as fast) to end the song in a big way.

4  On the Kick & Snare slider, click the last increment (8).

Now it sounds like you’ve unleashed Kyle! Playing double-time at that fast tempo
makes the sixteenth notes on the kick drum sound ridiculously fast.

5 On the XY pad, drag the puck toward the left until the drummer stops playing six-
teenth notes on the kick drum.

@

The performance now sounds more realistic while retaining the driving effect of its
double-time groove.

6 Listen to the last chorus and the outro.

The outro has the required power to drive the last four measures; however, it seems
like the drummer stops abruptly before finishing the fill. Usually drummers end a
song by playing the last note on the first beat of a new bar, but here a crash cymbal is
missing on the downbeat at bar 57. You will resize the last Outro region in the work-
space to accommodate that last drum hit.
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7  Resize the last Outro region to lengthen it by one beat (until the help tag reads
Length: 4100 +0100).

Outro

+0100

A moment after you release the mouse button, the Drummer region updates, and you
can see a kick and a crash on the downbeat at bar 57.

8 Listen to the outro. The drummer finishes the fill, punctuating it with the last hit
at bar 57.

NOTE » The final crash cymbal continues ringing until its natural sustain fades out,
well after the playhead has passed the end of the last Outro region.

You've laid out the entire song structure by creating section markers in the arrangement
track, populated each section with Drummer regions, and edited each region’s settings
to customize its drum pattern. You are now done editing the drum performance and can
focus on the sound of the drums.

Customizing the Drum Kit

When recording a live drummer in a studio, the engineer often positions microphones

on each drum. This allows control over the recorded sound of each drum, so he can indi-

vidually equalize or compress the sound of each kit piece. The producer may also want the
drummer to try different kicks or snares, or to experiment with hitting the cymbals softer

before he begins recording.
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In Logic, when using Drummer, the sounds of each drum are already recorded. However,
you can still use several tools to customize the drum kit and adjust the sound of each drum.

Adjusting the Drum Levels Using Smart Controls

Smart Controls are a set of knobs and switches that are premapped to the most important
parameters of the plug-ins on the channel strip of the selected track. You will study Smart
Controls in more detail in Lesson 5.

In this exercise, you will use Smart Controls to quickly adjust the levels and tones of dif-
ferent drums. Then you’ll open Drum Kit Designer to swap one snare for another and
fine-tune the crash cymbal sound.

1 In the control bar, click the Smart Controls button (or press B).

The Smart Controls pane opens at the bottom of the main window, replacing the
Drummer Editor. It is divided into three sections: Mix, Compression, and Effects.

In the Mix section, six knobs allow you to balance the levels of the drums. To the right
of each knob, a button lets you mute the corresponding drum or group of drums.

2 DPosition the playhead before the first chorus and start playback.
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3 Turn the cymbals down a bit by dragging the Cymbals knob.

Even with the Amount knob turned all the way down in the Compression section, the
compressor is still slightly processing the drum sound. Let’s turn it off.

4 In the Compression section, click the On button.

On the left channel strip in the inspector, the Compressor plug-in is dimmed, indicat-
ing that it is turned off.

5 In the Effects section, drag the Tone knob up.

o

As you drag up the knob, the drums’ sound changes timbre and becomes brighter. On
the left channel strip in the inspector, the EQ curve on the channel strip’s EQ display
reflects the changes made to the Channel EQ plug-in.

EQ display

MORE INFO » You will further examine the Channel EQ plug-in in Lesson 9.

6 Drag up the Room knob.

As you drag up the knob, you will start hearing the subtle reverberation of a drum booth.
In the inspector, you can see the Bus 1 Send knob move along with the Tone knob.
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MORE INFO » You will learn how to use bus sends to route an audio signal to a
reverb and to change the character of the reverb in Lesson 9.

7 In the control bar, click the Editors button (or press E) to open the Drummer Editor.

EI3» You can also double-click a Drummer region to open the Drummer Editor.

You have adjusted the levels and timbres of the drums, and you’re now ready to fine-tune
the sound of the individual drum kit pieces.

Customizing the Kit with Drum Kit Designer

Drum Kit Designer is the software instrument plug-in that plays drum samples triggered
by Drummer. It allows you to customize the drum kit by choosing from a collection of
drums and cymbals and tuning and dampening them.

1 At the bottom of the character card, click East Bay Kit to open Drum Kit Designer.

EII» 1o have the Drummer regions play a different instrument, you can choose
another patch from the Library or insert another software instrument plug-in on the
channel strip. You can also drag Drummer regions to another software instrument
track, and they are automatically converted to MIDI regions. (You will learn more
about MIDI in Lesson 5.)
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2 In Drum Kit Designer, click the snare.

You can hear the snare sample. The snare stays lit, and the rest of the drum kit is in
shadow. To the left, a Snares panel contains your choice of three snare drums, and to
the right, an Edit panel includes three setting knobs.

The left panel shows only a limited selection of snares. To gain access to the entire
collection of drum samples included with Logic Pro X, you need to choose a Producer
Kit in the Library.

R To trigger Drum Kit Designer from your iPad in Logic Remote, tap the View G2
menu and then tap Kits (you will learn how to use the Logic Remote in Lesson 5). L4

3 In the control bar, click the Library button (or press Y).

To the left of the inspector, the Library opens, listing patches for the selected track.
The current patch, East Bay, is selected.
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4

In the Library, select Producer Kits, and then select East Bay+.

Search Library

Producer Kits

The Drum Kit Designer window is reset.

MORE INFO » If the plug-in window now displays an EQ plug-in, close the plug-in
window; and click the button at the bottom of the character card to open the East
Bay+ Drum Kit Designer window.

The East Bay+ kit sounds the same as East Bay but allows a wide array of options to
customize the drum kit and its mix.

MORE INFO » In the track header, you may have noticed that the drum icon is now
framed in a darker rectangle with a disclosure triangle: The track is now a Track Stack
that contains one track for each microphone used to record the drum kit. Clicking the
disclosure triangle displays the individual tracks and their channel strips. You will use
Track Stacks in Lesson 5.

Click the Library button (or press Y) to close the Library window.

In Drum Kit Designer, click the snare.

This time the left pane displays a choice of 15 snare drums (use your mouse to scroll
down the list). The current snare, Black Brass, is selected.
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7 Click another snare, and then click the Info button next to it.

Classic Chrome

A description of the selected snare opens.

Classic Chrome

Continue previewing different snares, and try listening to a verse or a chorus to hear
your customized drum kit in action.

8 At the top of the left pane, click the Bell Brass snare.

9 In Drum Kit Designer, click the kick drum.

Maple Punch

Tune

Dampen




188 Produce a Virtual Drum Track

The info pop-up window updates to show you information on the selected kick drum.

Listen to the kick drum. This kick is the right choice for your song, but it has a long
resonance. Typically, the faster the tempo of the song, the less resonance you want on
the kick; otherwise, low frequencies build up and could become a problem during the
mix. You may have seen drummers stuff an old blanket in their kick drum to dampen
them. In Drum Kit Designer, you only have to raise the dampening level.

10 In the right pane, drag the Dampen knob up to about 75%, and click the kick to
listen to it.

The kick’s resonance is shortened.

You will now tune the toms, which are mainly used in the bridge section.
11 In the workspace, select the Bridge region.
12 In the Drummer Editor, click the Play button and mute the kick.

You can hear only the low and mid toms.

13 In Drum Kit Designer, click one of the toms.

The Edit panel opens with four tabs: All (for adjusting settings of all three toms in the
kit together); and Low, Mid, and High (for adjusting settings of each individual tom).

14 Click the Mid tab and raise the Tune knob to around +155 cent.

+155 cent

You can hear the mid tom being pitched up as Kyle continues repeating the first half
of the bridge.
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If you want, feel free to continue exploring Drum Kit Designer and adjusting the
sound of the hi-hat, ride, and crash cymbals.

15 Stop playback and close the Drum Kit Designer window.

You have exchanged the snare for another one that sounds a little clearer, dampened the
kick drum to tame its resonance, and tuned the mid tom to pitch it a bit higher. You have
now fully customized both the drum performance and the drum Kkit.

Working with an Electronic Drummer

When drum machines first made their appearance in recording studios, drummers feared
for their careers. The eighties produced a number of hit songs in which live drummers
were replaced by electronic drums programmed by music producers.

However, many producers quickly realized that to program exciting electronic drum beats,
they needed to develop the chops of a real drummer, while others simply chose to hire
drummers for this task. In Logic, you can use Drummer to create virtual drum machine
performances, turning beat creation into a fast and fun exercise.

Creating Hip Hop Beats

In this exercise, you will work with one of the Hip Hop drummers, adjusting its feel to
control the human quality in the timing, and later you'll convert the Drummer region to a
MIDI region to exercise complete control over each individual drum hit.

1 In the Drummer Editor, from the Genre pop-up menu, choose Hip Hop.

2 Select the last drummer, Maurice.

Hip Hop
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In the inspector, the Drum Kit Designer plug-in is replaced by Drum Machine
Designer. The Drummer Editor updates to display drum machine samples. On the
track, all the Drummer regions are refreshed to reflect Maurice’s playing style.

3 Listen to a few sections.

Maurice plays a very loose, swung hip-hop groove. Your project tempo is still set to
142 bpm, but the drummer plays half time, so it sounds like 71 bpm. Let’s work with
the verse.

4  Drag the first Verse Arrangement marker to the ruler.

Cycle mode is on, and the cycle area corresponds to the Verse marker.
5 Select the Drummer region below the cycle area, and press Z to zoom in.

6 In the Drummer Editor, click the Details button.

Swing

16th

Details [r

When the “Auto half-time” checkbox is selected, the drummer automatically switches
to half time when the project tempo is 110 bpm or faster; those fast tempos are rarely
used in hip-hop.

7 Deselect “Auto half-time”

The drummer now plays at 142 bpm, which is much too fast for hip-hop.
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Working with an Electronic Drummer

In the LCD display, set the tempo to 87 bpm.

Maurice plays a very loose, almost sloppy beat. Let’s tighten the performance.

Turn the Humanize knob all the way down.

The groove is now machine tight.

Turn the Swing knob up to 66%.

Swing

The drummer swings a little more, making the beat bouncier. Except for the fills at
the end of the fourth and eighth bars in the region, it keeps repeating a fairly similar
pattern. Let’s make it vary the pattern a little more.

Turn the Phrase Variation knob all the way up.

Now the beat is slightly different in every bar.

Let’s get rid of the crash cymbal on the first downbeat. Since the Drummer Editor
doesn’t give you complete control over every single drum hit, you need to convert the
Drummer region to a MIDI region.
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12 In the workspace, Control-click the selected Drummer region and choose Convert to
MIDI Region.

o Midi Region

The yellow Drummer region is replaced by a green MIDI region that plays the same
performance. The Drummer Editor is replaced by the Piano Roll Editor.

In the Piano Roll, the notes are represented by beams on a grid. The beams are posi-
tioned across a vertical piano keyboard that shows the MIDI note pitches. However,
when working with drums, MIDI note pitches do not help identify the sound of the
drums represented by each beam.
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13 In the Piano Roll, choose View > Drum Names.

1/16 Note

Major (0]

The vertical piano keyboard disappears, and the names of the drums are displayed in
front of the grid.

14 On the downbeat of bar 5, click the note representing the Crash cymbal.

15 Press Delete to delete the selected note.

The crash cymbal is no longer triggered at the beginning of the verse.

You have replaced the acoustic drummer with an electronic drummer, adjusted the num-
ber of variations he plays, and made his playing sound tighter. Finally, you converted a
Drummer region to a MIDI region to delete a single crash cymbal. In the next exercise,
you’ll explore the remaining parameters of the electronic Drummer Editor.
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Creating an Electro-House Track

When working with Drum Machine Designer, the Drummer Editor allows you to restrict
the complexity range of individual samples, making it possible to have, for example, a
simple kick and snare beat while another sample follows a more complex pattern.

You will now switch drummers to create an electro-house drum track, and you'll create a
ubiquitous four-on-the-floor kick and snare beat with a complex shaker pattern.

1 On the Drummer track, Control-click the MIDI region and choose Convert to Drum-
mer Region.

In the Drummer region, the crash at the beginning of the region reappears: When
you convert a MIDI region to a Drummer region, the region reverts to the Drummer
performance you had before converting the region to MIDI.

2 In the Drummer Editor, from the Genre pop-up menu, choose Electronic.

3  Select the first drummer, Magnus.

4 In the control bar, change the tempo to 132.

5 Listen to the verse.
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You hear a rather straightforward dance groove. You will first work on the kick and
snare beat.

6 In the Drummer Editor, click the Details button to go back to the basic view; and
mute the shaker, hi-hat, and handclaps.

Only the kick and snare are playing. On the upper line in the Drummer region, a sec-
ondary kick plays every bar. Let’s get rid of it.

7 In the XY pad, drag the puck to the left until the secondary kick disappears.

©

Now the snare may no longer play on beats 2 and 4 of every bar. You can fix that by
adjusting its complexity range.
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8 In the Drummer Editor, click the Details button.

You can drag the Complexity Range sliders for each individual drum piece to offset
the complexity set by the puck in the XY pad.

9 Drag the snare’s left Complexity Range slider toward the right until you hear the snare
play on beats 2 and 4 of every bar.

Let’s add a shaker to the party.

10 Click the shaker to unmute it.

The shaker plays a sixteenth note pattern, and it drops for a whole beat on beat 3 of
bars 5,7, 9, and 11. You are looking for a more consistent shaker groove.

11 Drag the shaker’s left Complexity Range slider all the way to the right.

The shaker now plays the same sixteenth note pattern throughout the region.

After exploring the Complexity Range sliders, you now have a solid understanding of all
the parameters in the Drummer Editor used by electronic drummers. It’s now time to
move on to the drum machine itself so you can customize the drum sounds.

Customizing the Drum Machine Sounds

Now that youre happy with the drummer performance, you can open Drum Machine
Designer to adjust the mix, change the snare sample, tune it, and add some reverb.

1 At the bottom of the character card, click the Plug-in button.
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Electronic

Big Room

Plug-in button

The Drum Machine Designer interface opens.

B Big Room
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&
.

2

3

The Drum Machine Designer interface consists of two parts:
Drums cells (at the top) to select and trigger individual drum samples.

Smart Controls (at the bottom) to adjust various parameters.

K> 1o trigger Drum Machine Designer from your iPad, in Logic Remote, tap the
View menu and then tap Drum Pads. (You will learn how to use the Logic Remote in
Lesson 5.)

In the Mix section, turn up the Perc & Shakers knob.

The shaker sounds a little louder.

In the Effects section, try turning up the Pulse and turning down the High Cut Filter.

The Pulse knob controls a pulsating filter that affects the shaker pattern, whereas the
High Cut Filter knob mulffles the entire kit.

K> To determine which plug-in a knob controls, Control-click the knob and
choose Open Plug-in Window.
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4 Click the buttons next to the Pulse and High Cut Filter knobs.

Both effects are turned off, and you can hear the full frequency range of the drum sounds.

NOTE » You will learn how to record knob movements in Lesson 10.

5 At the upper right of the Smart Controls, click the Sends button.

The Smart Controls display knobs that control the amount of delay and reverb for dif-
ferent drum kit elements.

6 In the Group Reverb section, turn Snare & Claps all the way up.

You can hear a short reverb added to the snare; however, that’s not the type of reverb
sound you're after. You will later find a more suitable reverb for this snare, so let’s turn
that one down.
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7 Turn Snare & Claps all the way down.

You will now swap the kit piece patch for the Snare.

8 Click the Snare 1 cell.

The Snare 1 cell is selected, and the Smart Controls update to display knobs affecting
that cell.

K> At the top of Drum Machine Designer, click the drum machine icon to return
to the main Smart Controls.

9 In the Snare 1 cell, click the S button.

Snare 1

Big Room

The snare is soloed.
10 Open the Library.

11 Choose Snare 2 — Analog Circuits.

In Drum Machine Designer, the cell displays the new patch name.
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12 In the Smart Controls, turn the Pitch knob down to A2.

13 Turn the Length knob down to shorten the snare sound.

In the inspector, the right channel strip controls the sound of the selected cell in
Drum Machine Designer. Lets add the desired reverb to the snare.

14 On the right channel strip in the inspector, click the first empty Audio FX insert in
the Snare 2 cell, and choose Reverb > PlatinumVerb.

15 In the PlatinumVerb window, from the Settings menu, choose Live Club.

Low Freq Level High Cut
/e Default
Recall Default

Am
Big Room |
t Long Verb

Live Club
Low Soft R
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16 In PlatinumVerb, drag the Wet slider up to increase the amount of reverb.

Dutput |
Iy

17 In Drum Machine Designer, click the S button in the Snare 2 cell to turn solo off.

You have adjusted the kit mix, played with some main effects, swapped one of the drum
samples, adjusted its sound, and added a plug-in to its channel strip to get the sound you
wanted.

You have produced drums for a whole song, and you’ve learned many ways to edit the
drummer’s performance and change the feel. You also customized drum Kkits to get your
desired sound. With Drummer, Drum Kit Designer, and Drum Machine Designer, Logic
Pro X allows you to quickly lay down a rhythmic foundation for a wide range of modern
music genres.

Lesson Review

How do you choose a drummer?

How do you choose a new drummer while keeping the current drum Kkit?
Where do you edit Drummer regions?

How do you mute or unmute drum parts?

How do you make the drummer play softer or louder, simpler or more complex?

AN A e

How do you access the Feel knob to make the drummer play behind or ahead of the
beat?

N

How do you open Smart Controls?
8. How do you open Drum Kit Designer or Drum Machine Designer?

9. When customizing an acoustic drum kit, how can you access all the available drum
kit pieces?

10. How do you dampen or tune an individual drum?
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11. How do you convert Drummer regions to MIDI regions?

12. How do you swap samples in Drum Machine Designer?

13. How can you use audio effect plug-ins for an individual cell in Drum Machine
Designer?

Answers

1. Click the drummer in the character card, or from the Genre pop-up menu, choose a
genre and then click the desired drummer.

2. Option-click the desired drummer.

3. Inthe Drummer Editor at the bottom of the main window

4. Click the drum parts in the drum kit that is displayed in the Drummer Editor.

5. Move the puck on the XY pad.

6. Click the Details button at the bottom right of the Drummer Editor.

7. Click the Smart Controls button in the control bar, or press B.

8. Click the Plug-in button at the bottom of the character card.

9. Select the appropriate Producer Kit in the Library.

10. In Drum Kit Designer, click a drum and adjust the settings in the Edit panel.

11. Select the regions, Control-click one of them, and choose Convert > Convert to
MIDI Region.

12. Click a cell and choose a new sample in the Library.

13. Click a cell and insert your plug-in on the right channel strip in the inspector.

Keyboard Shortcuts

Main Window

B Opens the Smart Controls

G Opens the global tracks

Command-Shift-N Opens a new file without opening the
Templates dialog

Y Opens the Library
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Lesson Files Logic Pro X Files > Lessons > 05 Dub Beat
Time This lesson takes approximately 120 minutes to complete.

Goals Record MIDI performances
Quantize MIDI recordings
Merge a MIDI recording with an existing MIDI region
Record MIDI in take folders
Create drum rolls and erase notes on the fly
Create Track Stacks
Save layered synthesizer patches
Map and assign Smart Controls
Record MIDI in step input mode
Use MIDI effects

Control Logic from an iPad using Logic Remote




Index

Numbers

16-Bit Recording, Audio
preferences, 67

24-Bit Recording, Audio
preferences, 67

32-samples I/O bulffer size, 102

44.1 kHz, music sample rate, 66

48 kHz, video sample rate, 66

128-samples, I/O buffer size, 101

A
AAC files, 520
Acoustic guitar
adjusting levels and pan, 432
submixing with summing
stacks, 433
Acoustic keyword, browsing/
previewing loops, 12-13
Action pop-up menu, 166
A/D (analog-to-digital) converter,
64
Adaptive Limiter feature, of
Compressor plug-in, 461-463
Add Device button, 503
Add Marker button, 170-172
Add Tracks button, 82
Adjust Tempo using Beat
Detection dialog
keyboard shortcut for, 367
setting project tempo,
320-322
Advanced Tools, preferences, 6
Aftertouch events, 523
AIFF (Audio Interchange File
Format)
Apple Loops as, 323
choosing audio file type, 104
defined, 520
sound quality and, 496
Alerts

confirming new audio file,
134
CPU overwork causing, 103
Delete alert, 78-79, 96
indicating prior use of
keyboard shortcuts, 88
tempo embedded into loops
and, 15
Aliases
defined, 520
MIDI regions, 380
Alignment Guides
keyboard shortcuts, 151
Snap pop-up menu, 144, 406
All Files Browser
creating audio track, 320
importing audio files,
135-136
importing MIDI files, 293
Alternative arrangements, editing/
saving, 387-389
Alternative option, drum genres,
161
Amp Designer plug-in
Bass Amp Designer, 51-52
customizing amp models,
425-430
emulating guitar amp, 71-72
inserting at specific points in
signal flow, 423-425
mixing with, 422
turning on/off, 127, 129-130,
134
Amplifier envelope (AMP ENV),
257
Amplitude peak, aligning audio
regions, 144
Amps
customizing amp models,
425-430

designing bass amp, 51-52
Amps & Pedals, Amp Designer
plug-in, 424
ANALOG, synthesizer engines, 253
Analog-to-digital (A/D) converter,
64
Analyzer button, turning on
frequency analyzer, 440-442
Anchors, for aligning audio
regions, 144-147
Apple Loops
adding, 12
adding piano loop to
arrangement, 38-39
adding with Loop Browser,
323-326
browsing/previewing loops,
12-16
choosing audio file type and,
104
converting loops to regions,
374-376
creating, 320-322, 327-331
defined, 520
folders for control loop
length, 376-379
keyboard shortcut for, 409
naming channel strips, 43-44
opening, 11-12
pitch and tempo independent
of project sample rate, 66
previewing, 39-40
Arming tracks, for recording, 520
Arpeggiator option
iPad keyboard options, 262
Synth channel, 253-257
Arpeggio, adding loops, 36-38
Arrangement tracks
defined, 520
marker use in, 169-173
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Index

Arrangements
adding lead synths, 35-38
building rhythm section,
23-28
building up by adding
melody, 35
creating breaks in, 38-43
editing. see Editing
arrangements
marker use in arrangement
track, 169-173
saving alternative, 387-389
of virtual drum track, 169
Arrow keys, for selections, 281-
282, 316
Attenuation, compressors and,
454-455
Audio
creating new project, 5-6
deleting unused audio files,
105-107, 109
editing. see Editing audio
keyboard shortcuts, 109
recording. see Recording
audio
sample rate, 66
Audio Click (Klopfgeist),
metronome settings, 99
Audio File Editor
defined, 521
destructive editing in,
140-141
keyboard shortcut for, 151
opening/closing, 145-146
playing audio regions
backwards, 142-143
Audio files
confirming new, 134
defined, 520
deleting unused, 97, 105-107,
109
destructive editing, 140-141
editing in Audio File Editor,
140
file type selection, 104-105
formats. see File formats
importing with All Files
Browser, 135-136
info column for, 106
mixing down to single stereo
file, 54-57

nondestructive editing, 116
playing audio regions
backwards, 142-143
rendering multiple regions in
single file, 384-387
reversing, 151
saving, 142
sound quality and file
formats, 496
Audio FX
accessing from iPad, 263
Amp Designer option, 71-72
Channel EQ option, 439,
489-490
customizing drum sounds,
201
dynamic processing plug-ins,
455, 459
Space Designer option,
450-451
Audio Interchange File Format. see
AIFF (Audio Interchange File
Format)
Audio interfaces
choosing inputs, 82-83, 508
defined, 521
microphone preamp included
in, 65
roundtrip latency and, 101
Audio MIDI Setup
creating external track for
synthesizer, 508-510
in Mac OS X, 502, 504-506
Audio preferences
bit depth, 66-67
choosing audio file type,
104-105
1/0 buffer size, 101, 103
Audio regions
aligning, 144-147
cloning, 379-382
defined, 521
editing, 135, 137-140
editing in workspace, 116-119
editing timing, 346
nondestructive editing, 111
playing backwards, 140-143
previewing, 112-114
removing silence from, 403
renaming, 114-116, 134

rendering multiple regions in
single file, 384-387
Audio settings, Project Setting
window, 65
Audio Track Editor
adding fades and crossfades,
111
editing note pitch, 362-366
editing regions, 135, 137-140
opening Audio File Editor,
142
playing audio regions
backwards, 142-143
Audio tracks
adding fades and crossfades,
111
creating, 68-71, 320
creating external track for
synthesizer, 508-510
multiple track recordings,
83-86
Automation
Automation Quick Access
feature, 492-494
bouncing mix, 495-498
defined, 521
keyboard shortcuts for, 499
lesson review, 498-499
live automation, 480
live automation of plug-in
bypass, 489-491
live automation of recording
in Latch mode, 485-489
live automation of recording
in Touch mode, 480-485
MIDI controllers in, 491-492
offline automation, 468
offline automation of muting
a channel strip, 477-480
offline automation of pan
region, 472-476
offline automation of vocal
track volume, 468-472
overview of, 467-468
Automation button, 469
Automation curves
creating sudden breaks, 488
muting Snare track, 474-476
panning effect, 474-476
ramp time of, 484



recording new frequency
values, 482-485
volume adjustment, 469-472
Automation Mode pop-up menu,
469
Automation Parameter pop-up
menu
Bypass option, 491
Mute option, 477
overview of, 469
Pan option, 474, 486
Automation preferences, 478-479,
493
Automation Quick Access,
492-494, 521
Automation Snap Offset, 478
Autopunch mode, 91-95, 109
Aux (auxiliary channel strip)
adding reverb with aux sends,
448-454
defined, 521

Balance, checking during single
track recordings, 75
Banjo
adding sections, 390-391
soloing, 371-372
Bar
of music, 521
Snap menu options, 117, 478
Bass
adding bass tracks, 19-20
adjusting note length,
279-281
building up rhythm section,
23-28
color code for, 370
creating break in arrangement
by removing, 38-39
creating split keyboard patch,
236-237
cutting sections and, 396-397
editing pitch using key
commands, 281-283
processing instrument quality
using plug-ins, 50
Skyline Bass option, 21-22
sorting search results by
tempo, 21

Stinger Bass option, 223
274-275
time-stretching a single notes,
354-356
Bass Amp Designer, 51-52
Beats. see also Tempo
Adjust Tempo using Beat
Detection dialog, 367
creating break in, 28-29
creating hip hop beats,
189-193
default operation of
metronome, 77
Intergalatic Beat option,
324-325
keyword button, 323
setting drum tempo from
control bar, 163
Ultrabeat instrument plug-in,
254
Beats per minute. see Bpm (beats
per minute)
Bit depth
digital recording and, 65
Info column for audio files,
106
setting, 66-67
Bounce
of automated mix, 495-498
keyboard shortcuts for, 60,
499
opening Bounce dialog, 54-56
rendering multiple regions in
single file, 385
Bpm (beats per minute). see also
Tempo
creating tempo changes and
curves, 334-337
setting drum tempo from
control bar, 163
varispeed options, 345-346
Broadcast Wave File (BWF),
104-105
Browser pane, 109, 293, 316
Browsers
audio projects. see Project
Audio Browser
files. see All Files Browser
loops. see Loop Browser
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Browsers button, control bar, 105,
135-136, 320
Brush patterns
defined, 521
defining, 291
Brush tool
creating custom note patterns,
290-292
Define Brush Pattern, 291
defined, 521
drawing note patterns, 287-290
Bus
adjusting reverb, 210-211
defined, 521
new aux with input set to bus
1,220
routing vocal track to aux,
449-453
Send knob and, 183-184
subtrack output set to bus2,
435
BWF (Broadcast Wave File),
104-105
Bypass
automating plug-in bypass,
489-491
defined, 521
effects, 385
Bypass parameter, Automation
Parameter pop-up menu, 491

C
Cables, for external MIDI devices,
503
CAF. see Core Audio Format
(CAF)
Capture as Recording, from
playback mode, 226
Cataloging, saving Apple Loops
for reuse, 327
Catch mode
defined, 522
playhead position and, 376
CD audio, 522
Channel EQ plug-in. see also EQ
plug-in
adjusting bands of, 439-444
adjusting drums using Smart
Controls, 183
adjusting levels and pan,
431-432
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automating bands of, 481-485
in Brooklyn drum kit patch,
220
creating software instrument
track, 210
inserting plug-ins at specific
points in signal flow, 424
Phone Filter Wide Band,
489-490
Channel strip setting, 207, 522
Channel strips
adjusting audio recording
levels, 72-74
adjusting volume levels and
stereo positions, 46-50
automation muting, 477-480
aux, 521
creating software instrument
track, 210
defined, 522
faders corresponding to, 263
faders on external MIDI
channel strip, 510
keyboard shortcuts for,
517-518
naming, 43-44
recording automation curves
for Output channel strip,
492-494
settings, 207, 522
tuning instruments, 75
Channels
assigning new track to, 69
defined, 522
Chords, Flex Time modes and,
348
Choruses. see also Vocals
automating bypass, 489-491
bridging choruses and verses,
177
copying and combining
regions, 172
creating arrangement marker
for, 171-172
creating track volume
automation, 468-472
editing, 179-181
Citrus Fuzz. see Fuzz options,
synthesizers

Clave
creating/drawing note
patterns, 287-290
defining/creating custom note
patterns, 290-292
Clean keyword, 36-37
Clipping
Adaptive Limiter preventing,
463
adjusting audio recording
levels and, 72
defined, 522
peak levels and, 460
Cloning audio regions, 379-382
Collapse mode, Piano Roll, 291,
522
Color
assigning colors to takes,
121-122
region color codes, 370
Command-click tool
accessing Text tool, 114
assigning Marquee tool to
mouse buttons, 118
assigning mouse tools, 112
Comp (composite) takes
creating automatically, 90
folder containing, 86
recording additional takes, 79
Comping takes
overview of, 123
previewing takes for, 120-123
process of, 123-127
Complexity Range slider, 196
Compression section, of Smart
Controls, 182-183
Compressor plug-in
Adaptive Limiter, 461-463
in Brooklyn drum kit patch,
220
compressing and limiting the
mix, 459-463
creating software instrument
track, 210
as dynamic processing plug-
ins, 454
gain reduction with, 455
inserting plug-ins at specific
points in signal flow, 424
parameters, 456

Platinum Analog Tape, 459
turning on/off, 128-130, 134
Vintage Opto mode, 457
Consoles, automated, 467
Continuous control number (cc#),
522
Control bar
Autopunch option, 91
Browsers button, 105, 135-
136, 320
Count-in button, 97
in default configuration of
main window, 9
defined, 522
Editors button, 140, 184
Go to Beginning (Return), 22,
83,472
Info button, 266
Library button, 209
Metronome button, 97
Mixer button, 209
navigating project with, 27
Play from Selection, 372
Record button, 76
setting tempo from, 163
Smart Controls button, 240
starting/stopping playback,
17-18
Tuner button, 74-75
Control surfaces (controllers). see
also MIDI controllers
assigning functions to control
knobs, 491-492
Automation Quick Access for
assigning single controller
knobs, 492-494
Control-change events, 523
Control-shift, cleaning up edits,
126
Copying material, to fill in parts,
373
Core Audio
defined, 522
1/0 buffer size and, 102-103
Core Audio Format (CAF)
choosing audio file type, 104
sound quality and, 496
Core MIDI, 522
Count-in
changing recording settings,
96-97



metronome setting, 77
recording takes in Cycle
mode, 81
Count-In/Clave
creating/drawing note
patterns, 287-290
defining/creating custom note
patterns, 290-292
CPU
I/O buffer size impacting
performance of, 102-104
Live mode impacting
performance of, 224
Creating/editing MIDI
creating crescendo using note
velocity, 299-302
creating/drawing note
patterns, 287-290
creating/resizing notes,
274-278
defining length of existing
notes, 278-281
defining/creating custom note
patterns, 290-292
editing MIDI data in Event
List, 294-296
editing note pitch using key
commands, 281-283
editing note velocity, 284-287
importing MIDI files,
292-294
keyboard shortcuts, 316
lesson review, 315
overview of, 273
quantizing note pitch, scale,
and timing, 296-299
Creating/editing MIDI continuous
controllers
automating modulation data
in MIDI Draw inspector,
311-314
automating pitch bend data
in MIDI Draw inspector,
302-307
copying MIDI control data
in MIDI Draw inspector,
307-311
overview of, 302
Crescendo, creating using note
velocity, 299-302

Crossfade. see also Fade-ins/outs
adding, 127
adding at junction between
two regions, 132-133
defined, 522
editing regions, 139-140
EqP (Equal Power Crossfade),
133
keyboard shortcuts, 151
making smooth transitions,
111
Customization
of control bar and display, 91
of drum kit, 181-182
of drum kit with Drum Kit
Designer, 184-189
of drum sounds using Drum
Machine Designer,
196-202
LCD display, 102
of main window, 9-11
Cycle area, replacing with skip
cycle area, 394
Cycle mode
adding bass track, 19-20
adjusting drummer settings,
164
adjusting instrument sounds,
48
defined, 523
ensuring playback starts at
beginning of section, 177
joining recordings into MIDI
region, 220-223
keyboard shortcut for, 59-61
making locators match
selected takes, 122
playing drummer, 161
playing MIDI regions, 215
recording MIDI takes,
223-226
recording takes in, 81-82
repeating and erasing notes
on the fly, 226
turning off, 22, 127
Cymbals
adjusting drummer settings,
168-169
adjusting using Smart
Controls, 183
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creating hip hop beats, 193

customizing drum kit, 189

editing drummer sections,
180

playing drum regions, 174

playing drummer region,
157-159

swapping instruments in
drum kit, 182

D
Dampen knob, customizing kicks,
188
Data
automating MIDI modulation
data, 311-314
controlling instrument
performance data, 273
copying MIDI control data,
307-311
editing MIDI data in Event
List, 294-296
DAW (Digital audio workstation),
523
Decibels full scale (dBFS)
adjusting audio recording
levels, 72
adjusting recording and
monitoring levels, 74
defined, 523
Define Brush Pattern, Brush tool,
291
Delay
adding to vocals, 445-448
customizing drum sounds,
199
Delay knob, Smart Controls, 314
Delete alert, 78-79, 96
Desktop
keyboard shortcuts for
accessing on Macs, 61
saving project to, 7-8
Destructive editing, in Audio File
Editor, 140-141
Details button, Drummer Editor
adjusting timing, 178-179
creating electro-house track,
195-196
creating hip hop beats, 190
Digital audio workstation (DAW),
523
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Digital recording. see Recording
audio
Distorted keyword, browsing/
previewing loops, 12-13
Distortion
adjusting recording levels to
avoid, 64
iPad keyboard options, 265
Dithering, sound quality and, 496
Drivers
adding external devices, 503
audio interface, 101
defined, 523
MID controller, 206
Drum keyword, browsing/
previewing loops, 12-13
Drum kit
adjusting settings, 168
Brooklyn patch, 220
choosing, 159-163
customizing, 181-182,
184-189
Drum Kit Designer
in Brooklyn drum kit patch,
220
customizing drum kit,
184-189
playing samples, 288
swapping instruments in
drum Kkit, 182
Drum Machine Designer
creating electro-house track,
194-196
creating hip hop beats, 190-193
customizing drum sounds,
198-202
interface options, 197-198
repeating and erasing notes
on the fly, 226-231
Drum pads. see XY pads
Drum tracks
adding Apple Loops to drum
track, 323-326
adding bass track using cycle
mode, 19-20
creating, 156-159
populating tracks with
regions, 173
track stacks for streamlining
workspace, 414-417
virtual. see Virtual drum track

Drummer Editor
adjusting drummer settings,
164-166
choosing drum kit and style,
159-163
choosing drummer and drum
kit, 156
creating electro-house track,
195-196
creating hip hop beats,
189-193
Details button, 178-179
Fills knob, 176
opening from control bar, 184
viewing drum region settings,
174
working with Drum Machine
Designer, 194
Drummer regions
converting MIDI region to,
194
converting to MIDI region,
184, 191-192, 287
copying and combining, 172
dividing Intro region,
175-176
navigating, 157
playing, 157-159, 174
populating tracks with
regions, 173
Drums
adding Apple Loops to drum
track, 323-326
adding bass track using cycle
mode, 19-20
adjusting levels using Smart
Controls, 182-184
as backbone of
instrumentation, 155
building up rhythm section,
23-28
choosing drum kit and style,
159-163
color code for, 370
creating break in arrangement
by removing, 38-39
creating tempo changes and
curves, 334-337
creating tracks, 156-159

creating virtual track. see
Virtual drum track
creating/drawing note
patterns, 287-290
creating/naming tempo sets,
332-334
defining/creating custom note
patterns, 290-292
editing performance, 163-169
Flex Time modes and, 348
icons for, 45-46
kicks. see Kicks
mute automation, 477-480
naming channel strips, 43-44
populating tracks with
regions, 173
saving drum section as Apple
Loop, 327-331
setting project tempo,
320-322
toms. see Toms
track stacks for streamlining
workspace, 414-417
working with electronic, 189
Dry signal, fine-tuning effects and,
71-72
Dynamic processing plug-ins
compressing and limiting the
mix, 459-463
Compressor plug-in, 454-458
overview of, 454

E
Editing arrangements
adding batch fades, 381-383
adding sections, 389-394
adding/deleting sections, 387
cloning audio regions,
379-382
copying material to fill in
parts, 373
cutting sections, 394-397
dividing regions by removing
silence, 401-404
editing regions, 405-407
folder use for control loop
length, 376-379
keyboard shortcuts, 409
lesson review, 408



looping regions using Loop
tool, 373-376
muting/deleting marquee
selections, 397-400
overview of, 369-370
previewing songs, 370-373
rendering multiple regions,
384-387
saving alternative
arrangements, 387-389
Editing audio
adding fade-outs, 127-130
adding fades to remove clicks,
130-134
aligning audio material to
grid, 144
assigning mouse tools, 112
comping takes, 123-127
correcting timing issues,
147-149
editing files, 140
editing regions in Audio
Track Editor, 137-140
editing regions in workspace,
116-119
grids for audio alignment,
144-147
importing audio files,
135-136
keyboard shortcuts, 151
lesson review, 150-151
overview of, 111
playing regions backwards,
140-143
previewing takes, 120-123
previewing/naming regions,
112-116
Editing MIDI. see Creating/editing
MIDI
Editing pitch and time
adding Apple Loops, 323-326
adding slow-down effects,
337-339
changing playback pitch and
speed, 342-346
creating Apple Loops, 320—
322,327-331
creating tempo changes and
curves, 334-337

creating/naming tempo sets,
332-334
editing note pitch in Audio
Track Editor, 362-366
editing note pitch in
workspace, 356-361
editing timing of audio
regions, 346
keyboard shortcuts, 367
lesson review, 366-367
making tracks play in same
groove, 340-342
moving waveform sections
without time-stretching,
351-353
overview of, 319
setting project key signature,
326-327
setting project tempo,
320-322
time-stretching a single note,
354-356
time-stretching waveform
between transient markers,
346-351
tuning vocal recordings, 356
Editing virtual drum track
bridge section, 177-179
chorus and outro sections,
179-181
drummer performance,
163-169
intro section, 173-177
Editors
defined, 523
MIDI. see MIDI editors
Editors area, MIDI, 316
Editors button, control bar, 140,
184
Effects
audio plug-ins, 422
bypassing, 385
creating software instrument
track, 210
customizing drum sounds,
198
guitar amplifier modeling
plug-in, 71-72
MIDI, 252
plug-ins causing latency, 104
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processing instrument quality
using plug-ins, 50-54
slow-down effects, 337-339
white noise sound effect, 136
Effects section, of Smart Controls,
182-183
Electric guitar. see also Guitars
adjusting levels and pan, 432
recording single tracks. see
Single track recordings
Electric piano, creating split
keyboard patch, 237
Electro-house track, 194-196
Electronic option, Genre pop-up
menu, 194
EQ display, Smart Controls, 183
EQ parameters, track automation
and, 371
EQ plug-in. see also Channel EQ
plug-in
adjusting guitar sound, 429
adjusting levels and pan,
430-432
attenuating or boosting
frequencies with EQ
plug-in, 439-445
bypass automation, 489-491
customizing drum kit, 186
mixing/adjusting vocals,
438-445
track automation, 391-392
EqP (Equal Power Crossfade), 133
Eraser tool, 289
ES2 plug-in
adjusting pitch bend range,
304-306
assigning MIDI controller
knobs to screen controls,
246
mapping plug-ins, 239-240
remapping control for
synthesizer filter, 242
Event List
defined, 523
editing MIDI data in, 294-296
Events, MIDL. see also Creating/
editing MIDI; Notes; Pitch
bend
assigning MIDI CC events to
channel strips, 492
defined, 523
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editing, 331
editing MIDI CC events, 468
joining recordings into MIDI
region, 218-219
processing in real time, 257
recording and, 212-215
routing to external
instrument, 206, 501,
507-510
routing to record-enabled
track, 207, 504
routing to virtual instrument,
206
turning into sound, 205
External Instrument plug-in,
506-508
External MIDI devices. see MIDI
devices, external

F
Factory layouts, 241-242
Fade tool
defined, 523
keyboard shortcuts, 151
Tool menu options, 128-129
Fade-ins/outs
adding batch fades, 381-383
adding fades and crossfades,
127-130
crossfades for smooth
transitions, 111
editing regions, 139-140
keyboard shortcuts, 151
removing clicks, 130-134
slow-down effects, 338-339
Faders
adjusting guitar levels and
pan, 431-432
corresponding to channel
strips, 263
defined, 523
on external MIDI channel
strip, 510
tremolo effect and, 437
Volume fader, 49, 207, 471
Feedback, avoiding in recordings,
69
Feel knob, options of Details
button of Drummer Editor,
179

File formats
Apple Loops options, 323
choosing audio file type, 104
Info column for audio files,
106
sound quality and, 496
File size, Info column for audio
files, 106
File Type Interleaved, sound
quality and, 496
File type, selecting for audio
recording, 104-105
Files
audio. see Audio files
creating new, 208
importing MIDI files,
292-294
opening, 156
saving as template, 514
Fills knob, Drummer Editor
adjusting drummer settings,
166
overview of, 176
Finder
configuring external MIDI
devices, 502
keyboard shortcuts for, 519
FireWire, configuring external
MIDI devices, 502
Flanger plug-in
assigning MIDI controller
knobs to screen controls,
246
mapping plug-ins, 240
remapping control for, 244
Flatten option, Take Folder
pop-up menu, 126
Flex editing
correcting timing issues,
147-149
defined, 523
editing note pitch in Audio
Track Editor, 362-366
editing note pitch in
workspace, 356-361
keyboard shortcuts, 367
moving waveform sections
without time-stretching,
351-353
setting Flex Mode to Flex
Time-Slicing, 334

time-stretching a single note,
354-356
time-stretching waveform
between transient markers,
346-351
FM (Frequency modulation),
synthesizer engines, 253
Folder stack, summing stack
compared with, 415-417
Folders
of comp (composite) takes, 86
defined, 376, 524
use for control loop length,
376-379
Format. see File formats
Frequencies
adjusting, 442-444
attenuating or boosting with
EQ plug-in, 438-439
automation curve recording
new frequency values,
482-485
turning on frequency
analyzer, 440-442
Frequency modulation (FM),
synthesizer engines, 253
Fuzz options, synthesizers
Citrus Fuzz, 294, 304-305
Moving Fuzz, 259, 262-264

G
Gain
Adaptive Limiter, 462-463
adjusting, 72, 442-444
controlling preamp remotely,
73
increasing on amp, 426
Gain Reduction meter, 455-456
Gate parameter, Note Repeat
feature and, 230
General MIDI (GM), 524
Genre
choosing drummer by, 159,
161
mixing and, 413
searching in Loop Browser
by, 21
Genre pop-up menu
Electronic option, 194
Hip Hop option, 189
Rock option, 156



Glissandro, iPad keyboard options,
261
Global tracks
closing, 336
configuring, 170
creating/naming tempo sets,
332-334
keyboard shortcuts, 203, 367
opening, 169
Go to Beginning (Return) button
control bar, 472
punching on the fly, 89-91
recording multiple tracks, 83
returning to beginning of
project, 22
Grids
for audio alignment, 144-147
defined, 524
keyboard shortcuts, 151
Snap to Grid, 145, 393, 395
Groove tracks
defined, 524
editing drummer sections
and, 180
making tracks play in same
groove, 340-342
Guitars
adjusting levels and pan,
430-432
assigning single controller
knobs, 494
color code for, 370
customizing amp models,
425-430
inserting plug-ins at specific
points in signal flow,
423-425
moving waveform sections
without time-stretching,
351-353
processing with tremolo
plug-in, 435-438
single track recordings, 76-79
submixing with summing
stacks, 432-435
time-stretching between
transient markers,
346-351
tuning, 74-75

H
Hardware, 502-506. see also MIDI
devices, external
HD meter, LCD display, 102
Headphones, monitoring
recording with, 70
Headroom
adjusting recording levels,
72,74
defined, 524
Help
getting element descriptions
from Quick Help, 10
Logic Remote Help, 269
Smart Help, 268
Help tag
defined, 524
region selections and, 26-27
Hide
inspectors, 9
keyboard shortcuts, 61, 499
Logic Pro X, 56
Show/Hide Automation
button, 469, 494
High Cut Filter, customizing drum
sounds, 198
Hi-hat
adjusting drummer settings,
164-168, 177
bridging choruses and verses,
178
changing to/from toms, 173
customizing drum kit, 189
MIDI controller option for,
221
playing drummer region,
157-158
recording at beginning of a
region, 228
Hip Hop
adding Apple Loops with
Loop Browser, 323-326
creating hip hop beats,
189-193
searching in Loop Browser by
genre, 21
Home folder, accessing, 293

|
IAC driver, external MIDI devices,
503
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Icons
choosing for tracks and
channel strips, 43-45
selecting for drum track,
45-46
selecting for guitar track, 70
Importing
audio files, 135-136
guitar recording, 147
MIDI files, 292-294
Indie rock example, 177-179
Info
accessing remotely, 266
column for audio files, 106
display in main window, 276
Input Device, Audio preferences,
66
Input menu
choosing audio interface
inputs, 508
choosing new input, 82-83
selecting audio interface input
number, 69
Insert slot
Audio FX slot on channel
strip, 51-52
for Channel EQ plug-in, 439
for Compressor plug-in, 456
defined, 524
for Tuner plug-in, 75
Inspectors
controlling preamp gain
remotely, 73
in default configuration of
main window, 9
defined, 524
hiding, 9
keyboard shortcut for, 59
MIDI Draw inspector. see
MIDI Draw inspector
Piano Roll inspector. see
Piano Roll inspector
Region Inspector. see Region
inspector
Smart Controls inspector, 241,
245-247
Track inspector. see Track
inspector
Volume fader in, 471-472
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Instruments. see also by individual
types
color coding, 370
connecting sound source
to Mac before recording
audio, 64
controlling performance data,
273
dragging regions to
instrument tracks, 147
External Instrument plug-in,
506-508
Live mode and, 224
monophonic and polyphonic,
348
processing quality using plug-
ins, 50-54
recording single tracks. see
Single track recordings
tuning, 74-75
virtual. see Virtual drum track
Interfaces
audio. see Audio interfaces
Drum Machine Designer,
197-198
exploring, 8-12
MIDI, 504-505
Intergalatic Beat option, 324-325,
327
Intro
creating arrangement marker
for, 170-172
playing drum regions, 174
1/O buffer size
changing recording settings,
100-104
defined, 524
iPad, Logic Remote app, 258-269

J
Join
recordings into MIDI regions,
216-223
rendering multiple regions in
single file, 384-387

K
Key, setting project key signature,
326-327
Key commands
assigning, 87-89

defined, 524
editing note pitch, 281-283
keyboard shortcuts, 109
navigating projects, 16-18
Record Toggle command, 87
remote control from iPad, 267
Key focus
determining if Loop Browser
has, 16-17
giving to Piano Roll, 281
giving to Tracks area, 17, 267
keyboard shortcuts for, 17, 60
Key signatures, 326-327. see also
Signatures
Keyboard shortcuts
for channel strip, track,
and region operations,
517-518
for Finder, 519
for navigation and playback,
516
for panes and windows,
515-516
for Piano Roll Editor, 519
for Project Audio Browser, 519
for zooming, 517
Keyboards
color code for, 370
piano. see Piano
Keyboards, MIDI
continuous controllers.
see MIDI continuous
controllers (MIDI CC)
as control surface, 492
creating split keyboard patch,
236-238
displaying on iPad, 260-263
editing note pitch using key
commands, 281-283
editing note velocity, 284-287
playing bass notes, 276
processing MIDI notes using
plug-ins, 252-257
recording, 212-215
Steinway Grand Piano patch,
294
Step Input keyboard, 249-251
using Mac keyboard as MIDI
controller, 206
Kick & Snare patterns, 180

Kicks. see also Drums
cloning audio regions,
379-382
creating electro-house track,
195
customizing drum Kkit,
187-189
folder use for control loop
length, 376-379
Kick & Snare patterns, 165
looping regions using Loop
tool, 373-376
MIDI controller option for,
221
playing drummer region,
157-158
previewing in song
arrangement, 370
rendering multiple regions in
single file, 384-387
repeating and erasing notes
on the fly, 226
track stacks for streamlining
workspace, 415-417
Klopfgeist (Audio Click),
metronome settings, 99

L
Latch mode, for automating
recordings, 485-489
Latency. see Roundtrip latency
Launchpad, opening Logic
Pro X, 4
Layouts, Factory layouts, 241-242
LCD display
changing loop tempo, 14-15
Custom option, 102
Customize Control Bar and
Display, 91
recording guitar part, 76
recording MIDI, 214
remote access from iPad, 265
showing playhead position, 27
Solo mode in, 371
Varispeed option, 343-344
viewing drum loop, 331
viewing MIDI activity,
212-213, 221
viewing project tempo in, 322
Lead Synth. see also Synthesizers
adding, 35-38



copying MIDI control data
in MIDI Draw inspector,
307-311
displaying MIDI events
in Lead Synth region,
295-296
quantizing pitch, scale, and
timing of, 296-299
Lead vocals, adding sections,
392-393
Learn by Key Label, 88-89
Learn mode
assigning MIDI controller
knobs to screen controls,
245-247
red halo indicating, 243
Left-click tool
accessing Solo tool, 112-114
accessing Velocity tool,
284-285
assigning mouse tools, 112
assigning Pointer tool to
mouse buttons, 118, 130
changing to Pointer tool, 286,
289
keyboard shortcuts, 151
Levels
adjusting drum levels,
182-184
adjusting recording levels,
72-74, 430-432
Library
accessing from control bar,
209
choosing bass option from,
274-275
defined, 525
joining recordings into MIDI
region, 220
keyboard shortcuts, 203
listing patches for selected
track, 185-186
Limiters, volume, 460-461
Live automation
overview of, 480
of plug-in bypass, 489-491
of recording in Latch mode,
485-489
of recording in Touch mode,
480-485

Live mode, instruments and, 224
Locators
adjusting cycle area, 23
defined, 525
keyboard shortcuts, 409
making match selected takes,
122
setting rounded locators, 20
Locked screensets
behavior of, 419-420
customizing, 420-422
Logic Remote app
defined, 525
remote control of Mac,
258-269
using iPad as wireless MIDI
controller, 206
Logic Remote Help, 269
Loop Browser
adding Apple Loops, 323-326
adding lead synths, 35-38
browsing/previewing loops,
12-16
cataloging Apple Loops, 327
determining if key focus
present, 16-17
dragging region to, 329
keyboard shortcut for, 59
MIDI regions for creating
Apple Loops, 331
opening, 12
resetting, 20, 39
saving drum section as Apple
Loop, 327-331
searching by genre, 21
Loop tool, 373-376
Loops. see also Apple Loops
defined, 525
use in modern music, 319
Loudness. see Volume

M
Mac OS X
Audio MIDI Setup, 502
keyboard shortcuts for, 61
remote control of Mac
computers, 258-269
using Mac keyboard as MIDI
controller, 206
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Main window
customizing, 9-11
default configuration of, 9
defined, 525
info display in, 276
keyboard shortcut for, 203
switching between Mixer and,
419-420
tool menus and, 115
Make Up knob, Compressor
plug-in, 458
Mapping
assigning functions to control
knobs, 491-492
opening mapping plug-ins,
239-240
Markers
cutting sections and, 395
defined, 525
in drum arrangement track,
169-173
for identifying project
sections, 370
moving waveform sections
without time-stretching,
351-353
mute automation of Snare
track, 477
time-stretching a single note,
354-356
time-stretching waveform
between transient markers,
346-351
Marquee tool
aligning notes in guitar track,
352-353
assigning to Command-click
button, 118
defined, 525
dividing drum Intro region,
175-176
making selections with, 328,
338
muting/deleting selections,
397-400
previewing loops, 39-40
selecting section of
automation curve,
471-472
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speeding up Autopunch
recording process, 95
from Tool menu, 116
Melody, building up arrangement
by adding to drums and bass,
35-38
Menu bar, main
Bounce dialog, 54
defined, 525
Screenset menu, 417
Menu bar, Piano Roll
Collapse Mode button, 291,
296
Time Handles, 288
Menu bar, Project Audio Browser,
107
Menu bar, Tracks area
Catch button, 376
Display Level button, 378
Drag mode, 119, 397
Flex button, 347, 362, 366
opening Tool menu, 115
Pack Folder function, 377
Show/Hide Automation
button, 469, 494
Snap pop-up menu, 117, 144,
390, 393, 406, 478
Vertical Auto Zoom button,
276
Zoom Focused Track, 475,
480
Metronome
adjusting timing, 178-179
changing recording settings,
97-100
default operation of, 77
defined, 525
quantizing MIDI regions, 216
recording MIDI, 213
setting project tempo, 320,
322
Microphone preamp
adjusting audio levels using
gain knob, 72
controlling gain remotely, 73
digital recording and, 64
included in most audio
interfaces, 65
Microphones
analog recording via, 64

connecting sound source
to Mac before recording
audio, 64
placement relative to speaker
cabinet, 428
positioning for drums, 181
MIDI (Musical Instrument Digital
Interface)
creating and editing. see
Creating/editing MIDI
defined, 525
recording. see Recording
MIDI
MIDI channels
defined, 525
routing external MIDI tracks,
509-510
routing MIDI events to, 507
viewing channel number of
MIDI event, 213, 294
MIDI Click, metronome setting,
99
MIDI continuous controllers
(MIDI CC)
assigning controller knobs to
screen controls, 245
automating modulation data,
311-314
automating pitch bend data,
302-307
automation and, 468
copying control data, 307-311
as MIDI event type, 205-206
overview of, 302
MIDI controllers
Automation Quick Access for
assigning single controller
knobs, 494
automation with, 491-492
MIDI Destination pop-up menu,
507-508
MIDI devices, external
choosing a program remotely,
510-514
creating external track for
synthesizer, 508-510
External Instrument plug-in,
506-508
hardware configuration,
502-506
overview of, 501

MIDI Draw
automating pitch bend data,
302-307
automation and, 468
defined, 525
MIDI Draw area of Piano
Roll, 299-300
MIDI Draw inspector
automating modulation data,
311-314
automating pitch bend data,
302-307
copying MIDI control data,
307-311
MIDI editors
Event List, 294-296
Piano Roll Editor, 274-278
types of, 273
MIDI note events
checking pitch and velocity
of, 277
correcting with Piano Roll
Editor, 215
creating crescendo using note
velocity, 299-302
creating/drawing note
patterns, 287-290
creating/resizing, 276-278
defining length of existing,
278-281
defining/creating custom note
patterns, 290-292
editing pitch using key
commands, 281-283
editing velocity, 284-287
enabling Note events button,
296
as MIDI event type, 205-206
order of play, 255-256
quantizing pitch, scale, and
timing, 296-299
recording one at a time, 247
viewing on LCD display, 213
MIDI Out, 283-284
MIDI plug-ins, 525. see also Plug-
ins
MIDI regions
aliases, 380
converting drummer region
to, 184, 191-192, 287



converting to drummer
region, 194
creating, 247, 275
defined, 526
dragging to Loop Browser to
create Apple Loop, 331
joining recordings into,
216-218
quantizing, 216-218
recording into selected,
218-219
selecting notes, 286
MIDI Thru Region inspector,
217-218, 226
Mix section, of Smart Controls,
182
Mixers
adjusting gain of microphone,
73
adjusting volume levels and
stereo positions, 46-50
controlling from Logic
Remote app, 258, 262-263,
265, 267, 269
defined, 526
examining channels strips,
208-211
keyboard shortcut for, 59
navigating with Tab key, 45
opening/closing, 43-44
processing guitars with
tremolo plug-in, 435-438
processing instrument quality
using plug-ins, 52-54
screensets for switching
between Tracks area and
Mixer, 417-420
submixing with summing
stacks, 432-435
Toolbar button, 10-11
Wide Channel Strips button,
421-422
Mixing
adjusting volume levels and
stereo positions, 46-50,
430-432
with Amp Designer, 422
automating. see Automation
choosing names and icons,
43-46

compressing and limiting the
mix, 459-463
Compressor plug-in, 454-458
controlling preamp gain
remotely, 73
customizing amp models,
425-430
customizing locked screenset,
420-422
defined, 526
delay added to vocals,
445-448
dynamic processing plug-ins,
454
EQ plug-in for, 438-445
inserting plug-ins at specific
points in signal flow,
423-425
keyboard shortcuts, 465
lesson review, 464
mixing down to single stereo
file, 54-57
opening Mixer remotely,
262-263, 265
organizing windows and
tracks, 414
overview of, 43, 413-414
processing guitars with
tremolo plug-in, 435-438
processing instrument quality
using plug-ins, 50-54
reverb added using aux sends,
448-454
screensets for switching
between Tracks area and
Mixer, 417-420
streamlining workspace with
Track Stacks, 414-417
submixing with summing
stacks, 432-435
tips and tricks, 463
Mixing boards, automated, 467
Modulation
automating modulation data,
311-314
processing guitars with
tremolo plug-in, 435-438
rate parameter and, 230
Monitoring effects, during single
track recordings, 71-72
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Monophonic, Flex Time mode,
348
More option, Region inspector,
133
Mouse tool
assigning, 112
converting into Resize pointer,
31-32
MP3 files
bouncing to desktop, 54-56
defined, 526
Multiple track recordings, 83-86
Multipressor plug-in, in Brooklyn
drum kit patch, 220
Multi-timbral
controlling timbres on
different channels, 213
defined, 526
Musical Typing window
defined, 526
keyboard shortcuts, 271
using Mac keyboard as MIDI
controller, 206
Mute
defined, 526
editing and arranging regions,
405
offline automation of channel
strip, 477-480
selections, 397-400, 409

Naming
regions, 112-116
tracks and channel strips,
43-46
Navigation
continuously repeating
sections, 19-23
creating markers for, 370
of drummer region, 157
keyboard shortcuts, 18, 59,
409, 516
overview of, 16
remotely from iPad, 265
transport buttons and key
commands, 16-18
New Tracks dialog
creating drummer track, 156
creating external track for
synthesizer, 508-510
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creating software instrument
track, 208, 220
creating split keyboard patch,
236-238
keyboard shortcuts, 109
preparing track for recording,
68-69
recording multiple tracks, 82
Noise. see also Volume
raising noise threshold when
stripping silence, 403
removing from arrangement,
397-400
Nondestructive editing
of audio regions, 111
Audio Track Editor, 137-140
defined, 526
editing regions in workspace,
116-119
fades and, 127
punching as, 86
working with regions in
workspace, 106
Normalize, peak levels and,
495-496
Note Repeat feature
defined, 526
drum machines, 226-230
Notes
checking pitch and velocity
of, 277
correcting with Piano Roll
Editor, 215
creating crescendo using
velocity, 299-302
creating/drawing note
patterns, 287-290
creating/resizing, 276-278
defining length of existing,
278-281
defining/creating custom note
patterns, 290-292
editing pitch in Audio Track
Editor, 362-366
editing pitch in workspace,
356-361
editing pitch using key
commands, 281-283
editing velocity, 284-287

enabling Note events button,
296

order of play, 255-256

quantizing pitch, scale, and
timing, 296-299

recording one at a time, 247

time-stretching, 354-356

viewing on LCD display, 213

(0

Octave buttons, offsetting pitch
range, 221
Octave Range option, MIDI
keyboard, 256
Offline automation
bouncing automated mix,
495-498
muting a channel strip,
477-480
overview of, 468
of pan region, 472-476
of vocal track volume,
468-472
Option-drag
copying and combining
regions, 172
copying/editing regions,
28-29
marquee selection, 118-119
Output channel strip
compressing and limiting the
mix, 459-462
defined, 526
Mixer and, 209
peak level display, 54
recording automation curves,
492
remotely controlling strip
Volume fader, 494
routing subtracks to, 416
submixing with summing
stacks and, 433
Output devices
Audio preferences, 66
selecting, 69
Output sliders
Amp Designer, 430
Tape Delay plug-in, 447-448

Outro
creating arrangement marker
for, 172-173
editing drummer sections,
179-181
Overdrive plug-in, accessing from
iPad, 264

P
Pan
adjusting, 430-432
automation of recording in
Latch mode, 485-489
Automation Parameter
pop-up menu, 474, 486
MIDI effects, 207
offline automation of pan
region, 472-476
Panes
keyboard shortcuts, 316, 367,
515-516
of main window, 8
navigating, 17
showing only needed, 12
Parameter Mapping, 242-245
Patches
accessing from Library,
206-211
Brooklyn drum kit patch, 220
creating layered sound patch,
231-236
creating split keyboard patch,
236-238
defined, 526
listed in Library, 185-186
mapping Smart Controls to
patch parameters, 239
saving, 234
Steinway Grand Piano patch,
294
PCM (pulse-code modulated
audio) files
bouncing automated mix as,
495-496
defined, 526
Peak levels
adjusting audio recording
levels, 72
adjusting recording and
monitoring levels, 74



Compressor plug-in, 460
Normalize and, 495-496
Pencil tool
creating notes, 276-278
defined, 526
defining length of existing
notes, 278-281
drawing automation curves
with, 471
resizing, moving, copying,
deleting MIDI notes, 274
Percussion
soloing, 371
track stacks for streamlining
workspace, 414-417
Perfect Pitch
editing note pitch in Audio
Track Editor, 363-364
tuning vocals on Verse track,
358-359
Phone Filter Wide Band, Channel
EQ, 489-490
Piano. see also Keyboards, MIDI
adding piano loop to
arrangement, 38-39
creating software instrument
track, 209-211
joining recordings into MIDI
region in Cycle mode,
220-223
quantizing MIDI regions, 216
recording MIDI, 213-215
soloing, 372
Steinway Grand Piano patch,
294
Piano Roll
Collapse Mode, 291
copying MIDI control data,
307-311
correcting MIDI notes, 215
deselecting all notes, 280
enabling MIDI Out, 284
joining recordings into MIDI
region, 218, 222-223
key focus given to, 281
keyboard shortcuts, 271, 316
MIDI Draw area of, 299-300
MIDI regions and, 192-193
quantizing MIDI regions,
216, 218
recording MIDI, 213-215

repeating and erasing notes
on the fly, 226
resizing, 275-276
step input mode example,
248-251
Time Handles option,
288-289
Piano Roll Editor
creating/resizing MIDI notes,
274-278
defined, 527
displaying Lead Synth region
in, 296-297
Drummer Editor replaced
by, 192
Event List compared with, 294
keyboard shortcuts for, 519
types of MIDI editors, 273
Piano Roll inspector
Scale Quantize pop-up menu,
297
selecting clave notes, 290-291
Time Quantize pop-up menu,
298
Velocity slider, 301
Piano rolls, MIDI sequences
compared to, 205
Pitch
adjusting on MIDI keyboard,
221
bending or modulating, 215
changing playback pitch and
speed, 342-346
checking note pitch, 277
controlling with Pitch Mod
knob, 242
correcting in vocal recordings,
356-361
editing. see Editing pitch and
time
editing note pitch in Audio
Track Editor, 362-366
editing note pitch in
workspace, 356-361
editing note pitch using key
commands, 281-283
Flex Time modes and, 348
quantizing note pitch,
296-299
sample rate impacting, 65-66

Index 545

viewing MIDI events on LCD
display, 213
Pitch bend
automating pitch bend data,
302-307, 309-311
overview of, 215
quantizing MIDI regions, 215
Pitch Drift settings, 364
Platinum Analog Tape,
Compressor plug-in, 459
Play from Selection, control bar,
372
Playback
changing pitch and speed,
342-346
continuously repeating project
sections, 19-23
of drum loop, 331
ensuring starts at beginning of
section, 177
keyboard shortcuts, 409, 516
of MIDI takes, 223-226
starting with spacebar, 20, 23
starting/stopping, 17-18
in Touch mode, 480
Playhead
defined, 527
jumping to selected region, 78
playing MIDI takes, 224-225
positioning, 18, 76
recording MIDI, 214
remote control from iPad, 265
starting/stopping playback
and, 17-18, 20, 23
in step input mode, 247
Plug-ins
adding delay to vocals,
445-448
Amp Designer. see Amp
Designer plug-in
amplifier modeling plug-in,
71-72
assigning MIDI controller
knobs to screen controls,
246
automating bypass, 489-491
in Brooklyn drum kit patch,
220
bypassing, 385
Channel EQ. see Channel EQ
plug-in



Index

compressing and limiting the
mix, 459-463

Compressor. see Compressor
plug-in

creating software instrument
track, 210

defined, 527

Drum Kit Designer and,
184-185

dynamic processing, 454

EQ. see EQ plug-in

ES2. see ES2 plug-in

External Instrument plug-in,
506-508

inserting at specific points in
signal flow, 423-425

latency and, 104

mapping screen controls
to plug-in parameters,
240-245

mapping with, 239-240

MIDI effects and, 252

mixing with, 422

Overdrive plug-in, 264

processing guitars with
tremolo plug-in, 435-438

processing instrument quality,
50-54

processing MIDI notes,
252-257

reverb plug-in, 448

settings saved in Library,
207-208

showing/hiding, 271

toggling on/off, 240

Tuner plug-in, 74-75

Ultrabeat instrument plug-in,
254

Pointer tool

adding fades to, 131

assigning Pointer tool to
mouse buttons, 130

assigning to Left-click button,
118

changing Left-click tool to,
286, 289

defined, 527

keyboard shortcuts, 151

selecting from Tool menu, 116

Polyphonic, Flex Time mode, 348
Ports, external MIDI devices, 503
Preferences
advanced Tools, 6
Audio preferences, 66
Automation preferences,
478-479, 493
closing Preferences window,
67
defined, 527
Prelisten button, previewing
regions, 106
Previewing
regions, 106, 112-116
songs, 370-373
takes, 120-123
Producer Kit, creating in Library,
185-186
Programming MIDI sequences,
273. see also Creating/editing
MIDI
Programs
choosing remotely, 510-514
defined, 527
Project Audio Browser
bounce file added to, 496
defined, 527
deleting unused audio files,
97, 105-107
dragging region to instrument
track, 147
keyboard shortcuts, 109, 519
Project Chooser, 4-5
Project Setting window, Audio
settings, 65
Projects
setting project key signature,
326-327
setting project tempo,
320-322
Projects, new
adding Apple Loops, 12
adding lead synths, 35-38
adjusting volume levels and
stereo positions, 46-50
browsing/previewing loops,
12-16
building arrangement, 35
building up rhythm section
of, 23-28

choosing and names and
icons, 43-46

continuously repeating
sections of, 19-23

creating breaks in
arrangement, 38-43

creating Logic Pro X, 4-8

creating MIDI project, 220

exploring interface, 8-12

keyboard shortcuts, 59-61

keyboard shortcuts for MIDI
project, 271

lesson review, 58-59

mixing, 43

mixing down to single stereo
file, 54-57

navigating generally, 16

navigating using transport
buttons and key
commands, 16-18

processing instrument quality
using plug-ins, 50-54

zooming in for editing
sections of, 28-35

Puck (yellow), on XY pad

adjusting drum levels,
175-176

adjusting drum presets, 164—
165, 168

bridging chorus and verses,
178

creating electro-house track,
195-196

editing drummer sections,
180

Pull knob, options of Details

button of Drummer Editor,
179

Pulse, customizing drum sounds,

198-199

Pulse-code modulated audio

(PCM) files

bouncing automated mix as,
495-496

defined, 526

Punching in/out

assigning key commands,
87-89

automatically, 91-95

defined, 527



on the fly, 89-91
keyboard shortcuts, 109
overview of, 86
Push knob, options of Details
button of Drummer Editor,
179

Q

Quantization
choosing default settings,
217-218
correcting timing of MIDI
recording, 215
defined, 527
of MIDI regions, 216, 221
note pitch, scale, and timing,
296-299
repeating and erasing notes
on the fly, 226-227
Time Quantize note value,
289-290
Quantize menu, Region inspector,
215-216
Quick Help, getting element
descriptions, 10
Quick Look window, playing file
in, 57
Quick Punch-In, 89
Quick Swipe Comping
assembling takes, 123-127
creating comp takes, 111
overview of, 121

R
Ramp time, automation curves,
484
Rate parameter, modulation and,
230
Ratio knob, Compressor plug-in,
458
Read mode
automation modes, 494
Touch mode compared with,
480
Realtime automation. see Live
automation
Record button
on control bar, 76
punching on the fly, 89-91
recording additional takes,
79-81

recording takes in Cycle
mode, 81-82
re-recording vocal recording,
94
Record Enable option
enabling tracks for recording,
69,71
recording multiple tracks,
82, 86
Record Toggle command
assigning keyboard
commands, 89
for punching on the fly, 87
punching on the fly, 87, 89-91
Recording audio
adjusting levels, 72-74
assigning key commands,
87-89
automation in Latch mode,
485-489
automation in Touch mode,
480-485
bit depth, 66-67
changing settings, 96
checking balance during, 75
count-in setting, 96-97
creating track for, 68-71
deleting unused files, 105-107
file type selection, 104-105
guitar part example, 76-79
I/O buffer size, 100-104
keyboard shortcuts, 109
lesson review, 108
metronome settings, 97-100
monitoring effects during,
71-72
multiple track recordings,
83-86
overview of, 63
positioning microphones, 181
punching automatically,
91-95
punching in/out, 86
punching on the fly, 89-91
recording additional takes,
79-81
recording takes in Cycle
mode, 81-82
sample rate, 65-66
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setting up digital recording,
64-65
single track recordings, 68,
79-82
tuning instruments, 74-75
Recording MIDI
assigning MIDI controller
knobs to screen controls,
245-247
choosing default quantization
settings, 217-218
correcting timing, 215
creating layered sound patch,
231-236
creating split keyboard patch,
236-238
joining recordings into MIDI
region, 220-223
keyboard shortcuts, 271
lesson review, 270
mapping screen controls
to plug-in parameters,
240-245
mapping Smart Controls to
patch parameters, 239
opening mapping plug-ins,
239-240
overview of, 205-206
process of, 212-215
processing MIDI notes,
252-257
quantizing MIDI regions, 216
recording into selected MIDI
region, 218-219
recording MIDI takes,
223-226
remote control using Logic
Remote app, 258-269
repeating and erasing notes
on the fly, 226-231
step input recording mode,
247-251
using patches from Library,
206-211
Redo, keyboard shortcut for, 60
Refresh Regions option, Action
pop-up menu, 166
Region inspector
adding batch fades, 381-383
defined, 527
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looping selected region,
378-379

MIDI Thru parameters,
217-218, 226

More option, 133

opening Track inspector,
237-238

quantizing MIDI regions,
215-216

repeating and erasing notes
on the fly, 226

selecting beat options, 23-26

slow-down effects, 339

Regions

audio. see Audio regions

batch fades, 381-383

cloning, 379-382

converting, 184, 191-192,
194, 287

copying and combining, 172

copying/editing, 28-29

defined, 527

displaying in Piano Roll
Editor, 296-297

displaying MIDI events in,
295-296

dividing by removing silence,
401-404

dragging to instrument track,
147

dragging to Loop Browser,
329

drummer. see Drummer
regions

editing, 405-407

editing in Audio Track Editor,
137-140

editing in workspace, 116-119

editing timing of, 346

folders of, 376

grids for aligning, 144-147

jumping playhead to selected,
78

keyboard shortcuts, 151, 409,
517-518

looping using Loop tool,
373-376

MIDI. see MIDI regions

nondestructive editing and,
106

offline automation of pan
region, 472-476
previewing/naming, 112-116
Refresh Regions option, 166
rendering multiple, 384-387
Select All (A), 54
selecting, 23-26, 37
zooming workspace out to
show all, 33
Remote control, using Logic
Remote app, 258-269
Repeat command
adjusting note length and,
279-281
cloning audio regions,
379-382
Replace mode, 527
Reset Pitch Curve, 365
Resize pointer
adjusting Mixer size, 46-47
converting mouse pointer to,
31-32
Resize tool
resizing notes, 277
snapping with, 117
Resolution (bit depth), 496
Resonance (width), adjusting, 442
Retro Synth option, 252-253, 257
Return key
navigating project, 27
returning to beginning of
project, 22, 59
Reverb
adding using aux sends,
448-454
customizing amp models,
426-427
customizing drum sounds,
199, 201-202
from MIDI piano instrument,
211
mute automation of Snare
track, 477-480
Reverb plug-in
inserting on aux, 450
overview of, 448
Rhythm. see also Tempo
building up rhythm section of
a project, 23-28
making tracks play in same
groove, 340-342

sample in building rhythm
parts, 373
Right-click tool, assigning mouse
tools, 116
Rim clicks, adjusting drummer
settings, 164
Ringshifter plug-in
opening mapping plug-ins, 240
remapping control for, 244
Rising Synth, 324-325
Rock option, drum genres, 156,
160
Roundtrip latency
defined, 524
effects plug-ins causing, 104
1/0 buffer size and, 101
reducing, 71
Ruler timeline
defined, 528
grid subdivision in, 27
positioning playhead, 18
Tracks area and, 9, 15
turning Cycle mode on/off,
19, 22
zooming out to show more
bars, 34

S

Sample accurate, 528
Sample rate
defined, 528
digital recording and, 65
Info column for audio files,
106
setting, 65-66
sound quality and, 496
Samples
in building rhythm parts, 373
use in modern music, 319
Save
alternative arrangements,
387-389
keyboard shortcuts for, 60
project for first time, 7-8
Scale
key values and, 326-327
quantizing note scales,
296-299
Scale Quantize pop-up menu, 297
Score Editor
defined, 528



Event List compared with, 294
types of MIDI editors, 273
Screen controls
assigning MIDI controller
knobs to, 245-247
mapping to plug-in
parameters, 240-245
Screensets
defined, 528
screenset, 420-422
for switching between Tracks
area and Mixer, 417-420
Scrubbing
defined, 528
regions using Solo tool,
113-114
Sections
adding, 389-394
cutting, 394-397
editing, 405-407
keyboard shortcuts, 409
markers for identifying, 370
saving alternative
arrangements, 387-389
Select All, 54, 316
Selections. see also Marquee tool
adjusting note length and, 280
Event List, 295
key commands, 281-282
keyboard shortcuts, 60, 316
of notes in MIDI region, 286
regions, 37, 151
of section of automation
curve, 471-472
Select All (A), 54, 316
zooming in to make, 120-121
Send levels
adjusting reverb, 211
defined, 528
Shakers
creating electro-house track,
196
customizing drum sounds,
198
making tracks play in same
groove, 341-342
Show Step Input Keyboard, 249
Show/Hide Automation button,
Tracks area, 469, 494

Signatures
deselecting signature tracks,
170, 332
Time and Key signatures in
Signature List, 326-327
transposing Apple Loops and,
325
Silence
dividing regions by removing,
401-404
inserting at locators, 389
removing from arrangement,
397-400
Single track recordings
adjusting recording levels,
72-74
checking balance during, 75
creating audio track for, 68-71
guitar part example, 76-79
monitoring effects during,
71-72
overview of, 68
recording additional takes,
79-81
recording takes in Cycle
mode, 81-82
tuning instruments, 74-75
Skip cycle area, 394
Slicing, Flex Time mode, 348
Slow-down effects, tempo,
337-339
Smart Controls
accessing remotely, 260
adjusting drum levels, 182-184
assigning MIDI controller
knobs to screen controls,
245-247
controlling from Logic
Remote app, 258, 269
customizing drum sounds,
199, 201
Delay knob, 314
keyboard shortcuts, 203, 271
mapping screen controls
to plug-in parameters,
240-245
mapping to patch parameters,
239
Smart Controls inspector, 241,
245-247
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Smart Help, 268
Smart option, Snap menu, 119
SMEF (Standard MIDI file) format
defined, 529
importing MIDI files,
292-294
Snap Automation, Snap menu
options, 478
Snap menu
Alignment Guides, 144, 406
Bar option, 117
options, 478-479
Quick Swipe Comping, 124
Smart option, 119
Snap Regions to Absolute
Value, 117
Snap to Grid, 145, 393, 395
Snap to Grid, 145, 393, 395
Snapping
aligning audio regions, 144
keyboard shortcuts, 151, 409
Snares. see also Drums
adjusting drummer settings,

164

bridging choruses and verses,
178

creating electro-house track,
195-196

customizing drum kit, 185-
187, 189

customizing drum sounds,
200-202

Kick & Snare patterns, 164,
180

MIDI controller option for,
221

mute automation, 477-480
playing drummer region,
157-158
repeating and erasing notes
on the fly, 226
swapping instruments in
drum kit, 182
Society of Motion Picture and
Television Engineers (SMPTE),
528
Software instrument track
creating, 208-209, 220, 274
creating split keyboard patch,
236-238
keyboard shortcuts, 271
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selecting, 223
sound layering and, 232
treated external device as
software instrument,
506-508
Software instruments, 528
Software Monitoring, 71
Solo
adjusting levels and pan,
430-432
cloning audio regions, 379
defined, 528-529
dividing regions by removing
silence, 401
editing and arranging regions,
405-406
keyboard shortcuts, 409
moving/deleting marquee
selection, 398
opening solo tracks, 409
previewing instruments,
370-373
previewing regions, 112-114
previewing songs, 370-371
Solo Kill/Recall button, 528
soloed region indicated by
yellow frame, 161
unsoloing a track, 127
Songs
editing arrangements. see
Editing arrangements
mixing. see Mixing
previewing, 370-373
Sound effects
panning effect, 474-476
white noise, 136
Sound layering, creating layered
sound patch, 231-236
Sound source, connecting to Mac
before recording audio, 64
Space Designer plug-in, Audio FX,
53, 450-451
Spacebar
navigating projects, 27
playing drummer region, 157
playing/stopping projects, 59
starting/stopping playback,
20, 23,75
Speed. see Velocity
Speed fades, turntable and tape
effects, 338-339

Spot Erase feature
defined, 529
drum machines, 226, 228-229
Standard MIDI file (SMF) format
defined, 529
importing MIDI files,
292-294
Steinway Grand Piano patch, 294
Step-input
defined, 529
mixing down to single stereo
file, 54-57
Step Input keyboard, 271
Step input recording mode,
247-251
Stereo
adjusting stereo field, 37-38
adjusting volume levels and
stereo positions, 46-50
spacing instruments in stereo
field, 437
Stinger Bass option
adjusting note length and,
280-281
choosing from Library,
274-275
Strip Silence
dividing regions by removing
silence, 401-404
keyboard shortcuts for
moving/cutting Strip
Silence window, 409
Style, virtual drum track, 159-163
Submixing, with summing stacks,
432-435
Summing stacks
creating, 233
folder stack compared with,
415-416
submixing with, 432-435
Sustain Inserted Notes button,
Step Input keyboard, 250
Swing knob, adjusting drummer
settings, 166
Synchronized oscillators (SYNC),
253
Synthesizers. see also Keyboards,
MIDI
adding external devices,
504-506
adding Lead Synths, 35-38

adding synth loop, 324-325

adjusting instrument sounds,
48-50

Arpeggiator option, 253-257

automating modulation data
in MIDI Draw inspector,
311-314

automating pitch bend data,
304-306

copying MIDI control data
in MIDI Draw inspector,
307-311

creating crescendo using note
velocity, 299-302

creating external track for,
508-510

creating layered sound patch,
231-236

defined, 529

Dirty Filth option, 239

displaying MIDI events
in Lead Synth region,
295-296

External Instrument plug-in
and, 506-508

Fuzz options, 294

importing MIDI files,
292-294

quantizing pitch, scale, and
timing, 296-299

Retro Synth option, 252-253

synthesizer engines, 253

turntable effect, 337-339

T
TABLE (Wavetable synthesis), 253
Take Folder pop-up menu
Flatten option, 126
multiple comps in, 124
previewing takes, 121
Takes
comping, 123-127
MIDI, 223-226
previewing, 120-123
recording additional, 79-81
recording in Cycle mode,
81-82
Tape Delay plug-in, adding delay
to vocals, 445-448



Tape recorders
slow-down effects, 337-339
varispeed techniques, 342-346
Templates, saving file as, 514
Tempo. see also Editing pitch and
time
adding Apple Loops to drum
track, 323-326
adding slow-down effects,
337-339
Adjust Tempo using Beat
Detection dialog, 367
changing, 14-15
creating electro-house track,
194
creating hip hop beats,
190-191
creating tempo changes and
curves, 334-337
creating/naming tempo sets,
332-334
defined, 529
drums providing foundation
of, 155
making tracks play in same
groove, 340-342
sample rate impacting, 65-66
setting drum tempo from
control bar, 163
setting project tempo,
320-322
sorting search results by, 21
varispeed options, 342-346
Tempo pop-up menu, 333
Tempo Sets, 333-334
Tempo tracks
creating tempo changes and
curves, 334-337
defined, 529
Text tool
defined, 529
renaming audio regions,
114-116, 134
Thresholds
Compressor plug-in, 456-457
raising noise threshold when
stripping silence, 403
Timbre
pitch correction and, 365
velocity and, 284

Time handles
creating original note patters,
292
defined, 529
time-stretching notes,
287-290
Time Handles option, Piano Roll,
288-289
Time Quantize pop-up menu,
Piano Roll, 298
Time signatures. see also
Signatures
4/4 time, 22, 27
control bar and, 9
defined, 529
in Signature List, 326-327
Time-stretching
defined, 529
moving waveform sections
without, 351-353
setting Flex Mode to Flex
Time-Slicing and, 334
single note, 354-356
waveform between transient
markers, 346-351
Timing. see also Tempo
of audio regions, 346
correcting audio timing
issues, 147-149
correcting MIDI timing, 215
editing. see Editing pitch and
time
metronome for experimenting
with, 178
quantizing note timing,
296-299
Toggles Note Repeat, 271
Toggles Spot Erase, 271
Toms
adding sections, 391
bridging choruses and verses,
178
changing to/from hi-hat, 173
customizing drum kit, 188
Tonality slider, metronome, 99-100
Tool menus
defined, 529
Fade tool, 128
keyboard shortcut, 115, 151
selecting tools from, 116
tracks area, 38
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Toolbars
defined, 529
keyboard shortcut for, 59
opening/closing, 9-10
Touch mode, automating
recording, 480-485
Track automation
defined, 530
EQ parameters and, 371,
391-392
muting Snare track, 474-480
offline automation of vocal
track volume, 468-472
Show/Hide Automation
button, 494
Track header
defined, 530
volume slider in, 471
Track inspector
choosing a program remotely,
511
defined, 530
opening, 237-238
setting Flex Mode to Flex
Time-Slicing, 334
Track Stacks
creating, 231, 233-234
defined, 530
keyboard shortcuts, 271
renaming, 235-236
for streamlining workspace,
414-417
submixing with summing
stacks, 432-435
Tracks
adding Apple Loops to drum
track, 323-326
automation keyboard
shortcuts, 499
creating audio track, 68-71,
320
creating electro-house track,
194-196
creating external track for
synthesizer, 508-510
creating new project, 5
creating tempo changes and
curves, 334-337
creating virtual drum track.
see Virtual drum track
defined, 529
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global. see Global tracks

keyboard shortcuts, 109, 409,
517-518

making tracks play in same
groove, 340-342

marker use in arrangement
track, 169-173

maximizing height and
visibility, 276

muting/unmuting, 234

naming, 78

naming before recording, 70

offline automation of vocal
track volume, 468-472

organizing, 414

recording multiple tracks,
83-86

recording single tracks. see
Single track recordings

tuning vocals on Verse track,
356-361

virtual instrument. see Virtual
drum track

Tracks area

adjusting note length and, 280

automation shortcuts, 499

creating new track, 68-69

in default configuration of
main window, 9

defined, 530

dragging region to, 141

Flex button, 347

giving key focus to, 17, 267

keyboard shortcuts, 271

maximizing track heights and
visibility, 276

naming channel strips, 44-45

Output Track, 492

screensets for switching
between Tracks area and
Mixer, 417-420

Show/Hide Automation
button, 469, 494

tool menus, 38-39

tuning vocals on Verse track,
356-361

Zoom Focused Track, 475

Transient markers

moving waveform sections
without time-stretching,
351-353

time-stretching a single note,
354-356
time-stretching between,
346-351
tuning vocals on Verse track,
357
Transport buttons, navigating
projects, 16-18
Transpose
to different key, 255
notes, 281-283
Tremolo plug-in, for processing
guitars, 435-438
Tuner button, control bar, 74-75
Tuning
instruments, 74-75
vocal recordings, 356-361
Turntables, slow-down effects,
337-339

U
Ultrabeat instrument plug-in, 254
Undo
comp, 124
deletion, 79
drummer edits, 164
keyboard shortcut for, 60
recording, 91, 97
USB, configuring external MIDI
devices, 502
User Patches, saving to Library,
234
Utilities, Audio MIDI Setup, 502

Vv
Varispeed techniques, 342-346
Velocity
changing playback pitch and
speed, 342-346
checking note velocity, 277
creating crescendo effect,
299-302
defined, 284, 530
editing note velocity, 284-287
Note Repeat feature and, 230
viewing MIDI events on LCD
display, 213
Velocity slider, Piano Roll
inspector, 301
Velocity tool, accessing from Left-
click menu, 284-285

Verses
bridging choruses and verses,
177
copying and combining
regions, 172
creating arrangement marker
for, 171-172
creating hip hop beats, 190
editing note pitch in Audio
Track Editor, 362-366
tuning vocals on Verse track,
356-361
Vibrato
automating modulation data
in MIDI Draw inspector,
309, 314
editing note pitch and, 356-
359, 362-364
Video sample rates, 66
View pop-up menu, resizing plug-
ins, 240
Vintage Opto mode, Compressor
plug-in, 457
Virtual drum track
adjusting levels using Smart
Controls, 182-184
arranging, 169
choosing drummer and style,
159-163
creating drummer track,
156-159
creating electro-house track,
194-196
creating hip hop beats,
189-193
customizing drum Kkit,
181-182
Drum Kit Designer for
customization of drum Kkit,
184-189
Drum Machine Designer for
customization of drum
sounds, 196-202
editing bridge section,
177-179
editing chorus and outro
sections, 179-181
editing drummer
performance, 163-169
editing intro section, 173-177
keyboard shortcuts, 203



lesson review, 202-203
marker use in arrangement

track, 169-173
overview of, 155

Virtual instruments, 530. see also

Virtual drum track

Vocals

adding delay, 445-448

adding sections, 389, 392-393

adjusting guitar levels and
pan, 431-432

attenuating or boosting
frequencies with EQ
plug-in, 439-445

automation in Latch mode,
485-489

automation in Touch mode,
481-485

autopunch example of vocal
recording, 93-95

color code for, 370

compressor used with, 454-458

creating track volume
automation, 468-472

cutting sections, 394-397

dividing regions by removing
silence, 401-404

editing and arranging regions,
405-407

live automation of plug-in
bypass, 489-491

muting/deleting marquee
selections, 397-400

reverb added using aux sends,
448-454

tuning vocal recordings,
356-361

Volume

adjusting levels and stereo
positions, 46-50

fade effects, 338-339

faders on external MIDI
channel strip, 510

lowering, 28

offline automation of vocal
track volume, 468-472

velocity and, 284

Volume fader

in inspector, 49, 471-472
MIDI effects, 207

Volume slider
metronome settings and, 99
in track header, 471
tuning instruments, 75

w

Waveform Zoom button, 138
Waveforms

Index 553

editing note pitch, 356-361
editing regions in Audio
Track Editor, 116-119
importing loop into, 15
keyboard shortcuts, 151
navigating remotely from
iPad, 267
nondestructive editing, 106

audio editing and, 111

of comp takes, 124-126

defined, 530

displaying in Audio Track
Editor, 137-138

Flex tool for correcting timing
issues, 148-149

making tracks play in same
groove, 340-342

moving waveform sections
without time-stretching,
351-353

muting/deleting marquee
selections, 398-400

re-recording vocal recording,
93-95

selecting audio waveform
icon, 70

time-stretching between
transient markers,
346-351

Wavetable synthesis (TABLE), 253
WAVE/WAV file format

choosing audio file type,
104-105

defined, 530

sound quality and, 496

Wide Channel Strips button,

Mixer, 421-422

Window menu, 419
Windows

keyboard shortcuts, 316, 367,
515-516

opening, 419

organizing, 414

Workspace

aligning audio regions,
144-147

defined, 530

dragging region to, 141

editing drummer sections,
179-181

selecting region in, 174
setting project tempo,
320-322
track stacks for streamlining,
414-417
zooming out to show all
regions, 33
‘Workstations, automated, 467
Write automation mode, 489

X
XY pads
adjusting drum levels,
175-176
bridging choruses and verses,
178
creating electro-house track,
195-196
editing drummer sections,
180
spot erase and, 229
using yellow puck on XY pad
for adjusting drum presets,
164-165, 168

4
Zoom Focused Track, Tracks area,
475
Zooming
automation shortcuts, 499
editing project sections, 28-35
keyboard shortcuts, 33-34,
60, 517
making selections, 120-121
playhead position and, 347
zoom out to view two regions,
159
Zoom tool, 530
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